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Important Information
Safety Cautions
Precautions
Please read this manual carefully before using your Dukane Projector and keep the manual
handy for future reference.Your serial number is located on the bottom of your projector.

CAUTION
To turn off main power, be sure to remove the plug from power outlet.
The power outlet socket should be installed as near to the equipment as possible, and should be easily
accessible.

CAUTION
TO PREVENT SHOCK, DO NOT OPEN THE CABINET.
NO USER-SERVICEABLE PARTS INSIDE.
REFER SERVICING TO QUALIFIED NEC SERVICE PERSONNEL.

This symbol warns the user that uninsulated voltage within the unit may be sufficient to cause electrical
shock. Therefore, it is dangerous to make any kind of contact with any part inside of the unit.

This symbol alerts the user that important information concerning the operation and maintenance of this
unit has been provided.
The information should be read carefully to avoid problems.

WARNING: TO PREVENT FIRE OR SHOCK, DO NOT EXPOSE THIS UNIT TO RAIN OR MOISTURE.
DO NOT USE THIS UNIT’S PLUG WITH AN EXTENSION CORD OR IN AN OUTLET UNLESS ALL THE PRONGS
CAN BE FULLY INSERTED.
DO NOT OPEN THE CABINET. THERE ARE HIGH-VOLTAGE COMPONENTS INSIDE. ALL SERVICING MUST
BE DONE BY QUALIFIED NEC SERVICE PERSONNEL.

DOC Compliance Notice (for Canada only)
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Acoustic Noise Information Ordinance-3. GSGV (for Germany only):
The sound pressure level is less than 70 dB (A) according to ISO 3744 or ISO 7779.

CAUTION
• Avoid displaying stationary images for a prolonged period of time.

Doing so can result in these images being temporarily sustained on the surface of the LCD panel.

If this should happen, continue to use your projector. The static background from previous images will disap-
pear.

WARNING TO CALIFORNIA RESIDENTS:
Handling the cables supplied with this product, will expose you to lead, a chemical known to the State of California
to cause birth defects or other reproductive harm. Wash hands after handling.
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RF Interference (for USA only)

WARNING
The Federal Communications Commission does not allow any modifications or changes to the unit EXCEPT those
specified by NEC Soluctions (America), Inc. in this manual. Failure to comply with this government regulation could
void your right to operate this equipment. This equipment has been tested and found to comply with the limits for a
Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference in a residential installation. This equipment generates, uses, and can radi-
ate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications. However, there is no guarantee that interference will not occur in a particular
installation.
If this equipment does cause harmful interference to radio or television reception, which can be determined by
turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the
following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

• Consult the dealer or an experienced radio / TV technician for help.

For UK only: In UK, a BS approved power cable with moulded plug has a Black (five Amps) fuse installed for use with
this equipment. If a power cable is not supplied with this equipment please contact your supplier.

Important Safeguards
These safety instructions are to ensure the long life of your projector and to prevent fire and shock. Please read them
carefully and heed all warnings.

Installation

1. For best results, use your projector in a darkened room.

2. Place the projector on a flat, level surface in a dry area away from dust and moisture.

3. Do not place your projector in direct sunlight, near heaters or heat radiating appliances.

4. Exposure to direct sunlight, smoke or steam can harm internal components.

5. Handle your projector carefully. Dropping or jarring can damage internal components.

6. Do not place heavy objects on top of the projector.

7. If you wish to have the projector installed on the ceiling:

a. Do not attempt to install the projector yourself.

b. The projector must be installed by qualified technicians in order to ensure proper operation and reduce the
risk of bodily injury.

c. In addition, the ceiling must be strong enough to support the projector and the installation must be in accor-
dance with any local building codes.

d. Please consult your dealer for more information.



iii

Important Information

Fire and Shock Precautions
1. Ensure that there is sufficient ventilation and that vents are unobstructed to prevent the build-up of heat inside

your projector. Allow at least 3 inches (10 cm) of space between your projector and a wall.

2. Prevent foreign objects such as paper clips and bits of paper from falling into your projector.

Do not attempt to retrieve any objects that might fall into your projector. Do not insert any metal objects such as
a wire or screwdriver into your projector. If something should fall into your projector, disconnect it immediately
and have the object removed by a qualified Dukane service personnel.

3. Do not place any liquids on top of your projector.

4. Do not look into the lens while the projector is on. Serious damage to your eyes could result.

5. Keep any items such as magnifying glass out of the light path of the projector. The light being projected from the
lens is extensive, therefore any kind of abnormal objects that can redirect light coming out of the lens, can
cause unpredictable outcome such as fire or injury to the eyes.

6. Do not cover the lens with the supplied lens cap or equivalent while the projector is on. Doing so can lead to
melting of the cap and possibly burning your hands due to the heat emitted from the light output.

7. The projector is designed to operate on a power supply of 100-240V AC 50/60 Hz. Ensure that your power
supply fits this requirement before attempting to use your projector.

8. Handle the power cable carefully and avoid excessive bending.

A damaged cord can cause electric shock or fire.

9. If the projector is not to be used for an extended period of time, disconnect the plug from the power outlet.

10. Do not touch the power plug during a thunderstorm. Doing so can cause electrical shock or fire.

11. Do not handle the power plug with wet hands.

CAUTION
• Do not try to touch the ventilation outlet on the left side (when seen from the front) as it can become heated

while the projector is turned on.

• Do no use the tilt-foot for purposes other than originally intended. Misuses such as gripping the tilt-foot or
hanging on the wall can cause damage to the projector.

• When carrying the projector by the carrying handle, make sure the two screws that attach the carrying handle
to the projector cabinet are tight. 

Insufficient tightening of the two screws could result in the projector falling and causing injury.

• Do not send the projector in the soft carrying case by parcel delivery service or cargo shipment. The projector
inside the soft carrying case could be damaged.

• Select [High] in Fan mode if you continue to use the projector for consecutive days. (From the menu, select
[Advanced] → [Fan Mode] → [High].)

• Do not unplug the power cable from the wall outlet under any one of the following circumstances.

Doing so can cause damage to the projector:

* While the Hour Glass icon appears.

* While the cooling fans are running. (The cooling fans continue to work for 30 seconds after the projector is
turned off).
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Lamp Replacement
• To replace the lamp, follow all instructions provided on page 53.

• Be sure to replace the lamp when the message “The lamp has reached the end of its usable life. Please
replace the lamp.” appears. If you continue to use the lamp after the lamp has reached the end of its usable
life, the lamp bulb may shatter, and pieces of glass may be scattered in the lamp case. Do not touch them as the
pieces of glass may cause injury.

If this happens, contact your Dukane dealer for lamp replacement.

• Allow a minimum of 30 seconds to elapse after turning off the projector. Then turn off the main power switch,
disconnect the power cable and allow 60 minutes to cool the projector before replacing the lamp.

Important Information
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� What's in the Box?
Make sure your box contains everything listed. If any pieces are missing, contact your dealer.
Please save the original box and packing materials if you ever need to ship your projector.
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For 8767A and 8070 only
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For 8771 only

 Remote mouse receiver
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1. Introduction

� Introduction to the Projector
This section introduces you to your new Dukane Projector and describes the features and controls.

Congratulations on Your Purchase of The Dukane Projector
The 8767A/8070/8771 is one of the very best projectors available today. The this projector
enables you to project precise images up to 300 inches across (measured diagonally) from your PC or Macintosh
computer (desktop or notebook), VCR, DVD player, document camera, or a laser disc player.
You can use the projector on a tabletop or cart, you can use the projector to project images from behind the screen,
and the projector can be permanently mounted on a ceiling*1. The remote control can be used wirelessly.

*1 Do not attempt to mount the projector on a ceiling yourself.

The projector must be installed by qualified technicians in order to ensure proper operation and reduce the
risk of bodily injury.

In addition, the ceiling must be strong enough to support the projector and the installation must be in accor-
dance with any local building codes. Please consult your dealer for more information.

Features you'll enjoy:
• Auto vertical keystone correction up to +/– 30 degrees

• Built-in Wall Color Correction presets provide for adaptive color correction when projecting onto non-white
screen material.

• Quick Start & Quick Shutoff

The quick start & quick shutoff function means you can set up or put away the projector without delay.

Nine seconds after turning on the power, the projector is ready to display PC or video images.

When you're finished, the fans stop in 30 seconds after turning off the power, so you can put away the projector
quickly after the conference or class.

• Low level operation noise

• Short focal length lens

• 130W lamp (110W Eco mode) : 8771
180W lamp (150W Eco mode) : 8767A/8070

• Direct keys for source selection

• New Color Management system

• New menu design improves operation

• Safety protect by Security function
Security feature prevents the projector from being used by unauthorized individuals.
Keyword prevents unauthorized individuals from changing projector settings or adjustments.

• Exclusive Advanced intelligent pixel blending technology - an extremely accurate image
compression technology - offers a crisp image with UXGA (1600�1200) resolution*2.

• Supports most IBM VGA, SVGA, XGA , SXGA/UXGA, Macintosh, component signal
(YCbCr/ YPbPr) or any other RGB signals within a horizontal frequency range of 24 to 100 kHz and a
vertical frequency range of 50 to 120 Hz. This includes NTSC, PAL, PAL-N, PAL-M, PAL60, SECAM and
NTSC4.43 standard video signals.

*2 A UXGA (1600�1200) and SXGA image (1280�1024) are on 8767A and 8771.

A UXGA (1600�1200), SXGA (1280�1024) and XGA (1024�768) image are displayed on 8070.
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NOTE: Composite video standards are as follows:
NTSC: U.S. TV standard for video in U.S. and Canada.
PAL: TV standard used in Western Europe.
PAL-N: TV standard used in Argentine, Paraguay and Uruguay.
PAL-M: TV standard used in Brazil.
PAL60: TV standard used for NTSC playback on PAL TVs.
SECAM: TV standard used in France and Eastern Europe.
NTSC4.43: TV standard used in Middle East countries.

• You can use the supplied wireless remote control and remote mouse receiver to operate your PC mouse
wireless from across the room. The remote mouse receiver supports almost any PC using a USB connection
(8767A AND 8070).

• You can control the projector with a PC or control system using the PC Control port.

• The contemporary cabinet design is light, compact, easy to carry, and complements any office, boardroom or
auditorium.

About this user's manual
The fastest way to get started is to take your time and do everything right the first time. Take a few minutes now to
review the user's manual. This may save you time later on. At the beginning of each section of the manual you'll find an
overview. If the section doesn't apply, you can skip it.

• IBM is a trademark or registered trademark of International Business Machines Corporation.

• Mac and PowerBook are trademarks of Apple Computer, Inc., registered in the U.S. and other countries.

• Windows, Windows 98, Windows Me, Windows XP or Windows 2000 are trademarks or registered trademarks
of Microsoft Corporation.

• Other product and company names mentioned in this user’s manual may be the trademarks or registered
trademarks of their respective holders.

1. Introduction
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� Part Names of the Projector
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AC IN
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VIDEO
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AUDIO OUT
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COMPUTER 1 IN

COMPUTER  OUT PC CONTROL

AUDIO

AUDIO

COMPUTER 2 IN

VIDEO IN
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R

AUDIO

L/MONO

R

Zoom Lever

(See page 28)

Controls
(See page 6)

Lens

Lens Cap

Built-in Security Slot (  )*

Focus Ring
(See page 28)

Adjustable Tilt Foot Lever
(See page 27)

Adjustable Tilt Foot
(See page 27)

Remote sensor
(See page 10 for 8767A/8070)

(See page 12 for 8771)

Ventilation (inlet) / Filter Cover
(See page 51)

Ventilation (inlet)

Front/Top

AC Input
Connect the supplied power cable's two-pin plug here, and
plug the other end into an active wall outlet. (See page 22)

Main Power Switch
When you plug the supplied power cable into an active wall outlet
and turn on the Main Power, the POWER indicator turns orange
and the projector is in standby mode.
(See page 23)

Remote sensor
(See page 10 for 8767A/8070)
(See page 12 for 8771)

Terminal Panel
(See page 7)

Monaural Speaker
(1W)

Rear

* This security slot supports the MicroSaver ® Security System. MicroSaver ® is a registered trademark of
Kensington Microware Inc. The logo is trademarked and owned by Kensington Microware Inc.

Ventilation (outlet)
Heated air is exhausted from here.

FOCUS

ZOOM
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For 8767A and 8070 only

Attaching the supplied carrying handle
You can carry the projector by attaching the supplied carrying handle securely to the projector.
To attach the supplied carrying handle, use the supplied flathead screwdriver and two screws.
Place a soft cloth on the working surface before turning the projector over to prevent scratching the top cover.
Make sure that the carrying handle is attached with correct orientation as shown below.

Bottom

Adjustable Tilt Foot
(See page 27)

Adjustable Tilt Foot Lever
(See page 27)

Adjustable Tilt Foot Lever
(See page 27)

Lamp Cover
(See page 53)

CAUTION
When carrying the projector by the carrying handle, make sure the two screws that attach the carrying handle
to the projector cabinet are tight.

Carrying handle

Screw

Flathead screwdriver
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Top Features

LAMP

STATUS

POWER VIDEO

AUTO
ADJ.

S-VIDEO COMPUTER-1 COMPUTER-2

ON/STAND BY

SELECT

12 13

10 2 3 411

1 5 6 7 8

9

1. POWER Button (ON / STAND BY) (  )
Use this button to turn the power on and off when the
main power is supplied and the projector is in standby
mode.
To turn on the projector, press and hold this button for
a minimum of two seconds. To turn off the projector,
press this button twice.

2. POWER Indicator
When this indicator is green, the projector is on; when
this indicator is orange, it is in standby mode. See the
Power Indicator section on page 56 for more details.

3. STATUS Indicator
If this light blinks red rapidly, it indicates that an error
has occurred, the lamp cover is not attached properly
or the projector has overheated. If this light remains
orange, it indicates that you have pressed a cabinet
key while the Cabinet Button Lock is enabled. See the
Status Indicator section on page 56 for more details.

4. LAMP Indicator
If this light blinks red rapidly, it's warning you that the
lamp has reached the end of its usable life. After this
light appears, replace the lamp as soon as possible
(See page 53). If this is lit green continually, it indi-
cates that the lamp mode is set to Eco. See the Lamp
Indicator section on page 56 for more details.

5. VIDEO Button
Press this button to select a video source from a VCR,
DVD player, laser disc player or document camera.

6. S-VIDEO Button
Press this button to select an S-Video source from a
VCR, DVD player, laser disc player or document cam-
era.

7. COMPUTER1 and 2 Buttons

Press this button to select an RGB source from com-
puter or component equipment connected to your
COMPUTER 1 or 2 port.

8. AUTO ADJ. Button
Use this button to adjust an RGB source for an opti-
mal picture (See page 31).

9. Source Indicators
When one of the COMPUTER, VIDEO or S-VIDEO
input is selected, the corresponding source indicator
lights.

10. MENU Button
Displays the menu.

11. SELECT ���� / Volume Buttons
�� : Use these buttons to select the menu of the

item you wish to adjust.
�� : Use these buttons to change the level of a se-

lected menu item. A press of the � button ex-
ecutes the selection. When no menus appear,
these buttons work as a volume control.

When an image is magnified, the SELECT ����
button moves the image.

12. ENTER Button
Executes your menu selection and activates items
selected from the menu.

13. EXIT Button
Pressing this button will return to the previous menu.
While you are in the main menu, pressing this button
will close the menu.
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AUDIO OUT

AUDIO

S-VIDEO IN

COMPUTER 2 INVIDEO IN COMPUTER 1 IN

MONITOR  OUT
PC CONTROL

L/MONO R

AUDIO
L/MONO R

AUDIO

4 1

3 2 5

Terminal Panel Features

1. COMPUTER 1 and 2 IN / Component Input Connector
(Mini D-Sub 15 Pin)

Connect your computer or other analog RGB equip-
ment such as IBM compatible or Macintosh comput-
ers. Use the supplied RGB cable to connect to your
computer. This also serves as a component input con-
nector that allows you to connect a component video
output of component equipment such as a DVD player.
This connector also supports SCART output signal.
See page 18 for more details.

COMPUTER AUDIO Input Mini Jack (Stereo Mini)

This is where you connect the audio output from your
computer or DVD player when connected to the COM-
PUTER input. A commercially available audio cable is
required.

2. MONITOR OUT Connector (Mini D-Sub 15 Pin)

You can use this connector to loop your computer
image to an external monitor from the RGB input
source.

This connector outputs RGB signal in standby mode.

AUDIO OUT Mini Jack (Stereo Mini) 

You can use this jack to output sound from the cur-
rently selected source (COMPUTER, VIDEO or S-
VIDEO). Output sound level can be adjusted in accor-
dance with the sound level of the internal speaker.

Note that this cannot be used as a headphone jack.

(When audio equipment is connected, the projector
speaker is disabled.)

When a cable mini-plug is inserted into this jack, both
the right and left audio signals are not mixed, but sepa-
rate.

For example, when a cable mini-plug is inserted into
the left AUDIO IN jack only, only left sound is output.

3. S-VIDEO IN Connector (Mini DIN 4 Pin)

Here is where you connect the S-Video input from an
external source like a VCR.

NOTE: S-Video provides more vivid color and higher
resolution than the traditional composite video format.

S-VIDEO AUDIO Input Jacks L/R (RCA)

These are your left and right channel audio inputs for
stereo sound from an S-Video source.

4. VIDEO IN Connector (RCA)

Connect a VCR, DVD player, laser disc player, or docu-
ment camera here to project video.

VIDEO AUDIO Input Jacks L/R (RCA)

These are your left and right channel audio inputs for
stereo sound from a Video source.

5. PC CONTROL Port (DIN 8 Pin)

Use this port to connect a PC or control system. This
enables you to control the projector using serial com-
munication protocol. If you are writing your own pro-
gram, typical PC control codes are on page 65.
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� Part Names of the Remote Control

NOTE: If you are using a Macintosh computer, you can click
either the MOUSE R-CLICK or MOUSE L-CLICK button to
activate the mouse.

1. Infrared Transmitter
Direct the remote control toward the remote sensor
on the projector cabinet.

2. POWER ON Button
When the main power is on, you can use this button
to turn your projector on.

NOTE: To turn on the projector, press and hold the POWER
ON button for a minimum of two seconds.

3. POWER OFF Button
You can use this button to turn your projector off.

NOTE: To turn off the projector, press the POWER OFF
button twice.

4. MAGNIFY (+)(–) Button
Use this button to adjust the image size up to 400%.
The image is magnified about the center of the screen.
See page 33.
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21
19

16
15
18

5

17

5. PIC-MUTE Button
This button turns off the image and sound for a short
period of time. Press again to restore the image and
sound.

6. PAGE UP/DOWN Button
Use these buttons to operate your computer with the
supplied remote mouse receiver. See page 34. You
can use these buttons to scroll the viewing area of the
window or to move to the previous or next slide in
PowerPoint on your computer.

7. MENU Button
Displays the menu for various settings and adjust-
ments.

8. SELECT ���� (Mouse) Button
�� : Use these buttons to select the menu of the

item you wish to adjust.
�� : Use these buttons to change the level of a se-

lected menu item. A press of the � button ex-
ecutes the selection.

When an image is magnified, the SELECT ����
button moves the image. See page 33.

9. ENTER Button
Use this button to enter your menu selection. It works
the same way as the ENTER button on the cabinet.
See page 6.

10. EXIT Button
It works the same way as the EXIT button on the cabi-
net. See page 6.

11. MOUSE L-CLICK Button
This button works as the mouse left button when the
supplied remote mouse receiver is connected with your
computer. See page 34.

12. MOUSE R-CLICK Button
This button works as the mouse right button when the
supplied remote mouse receiver is connected with your
computer. See page 34.

13. VIDEO Button
Press this button to select a video source from a VCR,
DVD player, laser disc player or document camera.

14. S-VIDEO Button
Press this button to select an S-Video source from a
VCR.

15. COMPUTER 1/2 Button
Press this button to select COMPUTER 1 or 2 (or Com-
ponent) input.

For 8767A/8070
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16. AUTO ADJ. Button
Use this button to adjust an RGB source for an opti-
mal picture.
See page 31.

17. VOLUME (+)(–) Button
Press (+) to increase the volume and (–) to decrease
it.

18. ASPECT Button
Press this button once to display the Aspect Ratio
select menu. Keep pressing will change aspect ratios.
See page 42.

19. PICTURE Button
Press this button to display the Picture adjustement
menu to adjust Wall Color, Picture Management,
Brightness, Contrast, Sharpness, Color and Hue. See
pages 40 to 41.

20. HELP Button
Provides the information on the current signal and pro-
jector settings. See page 49.

21. FREEZE Button
This button will freeze a picture. Press again to re-
sume motion. See page 33.
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Remote Control Precautions
• Handle the remote control carefully.
• If the remote control gets wet, wipe it dry immediately.
• Avoid excessive heat and humidity.
• If you will not be using the remote control for a long time, remove the batteries.
• Do not place the batteries upside down.
• Do not use new and old batteries together, or use different types of batteries together.

Operating Range for Wireless Remote Control

Battery Installation

1 Press firmly and slide the
battery cover off.

2 Remove both old batteries and
install new ones (AAA). Ensure
that you have the batteries' po-
larity (+/–) aligned correctly.

3 Slip the cover back over the bat-
teries until it snaps into place. Do
not mix different types of batter-
ies or new and old batteries.

Remote sensor on projector cabinet Remote control

7m/22 feet

7m/22 feet

• The infrared signal operates by line-of-sight up to a distance of about 22 feet/7 m and within a 60-degree angle of
the remote sensor on the projector cabinet.

• The projector will not respond if there are objects between the remote control and the sensor, or if strong light falls
on the sensor. Weak batteries will also prevent the remote control from properly operating the projector.
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1. Introduction

SOURCE PIC-MUTE

POWERASPECT

SELECT

3

6

4

2

1

8

7

5

9

For 8771

1. Infrared Transmitter
Direct the remote control toward the remote sensor
on the projector cabinet.

2. MENU Button
Displays the menu for various settings and adjust-
ments.

3. SELECT ���� / Volume Buttons
�� : Use these buttons to select the menu of the

item you wish to adjust.
�� : Use these buttons to change the level of a se-

lected menu item. A press of the � button ex-
ecutes the selection. When no menus appear,
these buttons work as a volume control.

4. ENTER Button
Executes your menu selection and activates items se-
lected from the menu.

5. EXIT Button
Pressing this button will return to the previous menu.
While you are in the main menu, pressing this button
will close the menu.

6. SOURCE Button
Press this button to select a video source such as a
PC, VCR or DVD player. Each time this button is
pressed, the input source will change as follows:

8771

Computer1 → Computer2 → Video → S-Video →
Computer1 → ...

7. PIC-MUTE Button
This button turns off the image and sound for a short
period of time.
Press again to restore the image and sound.

8. ASPECT Button
Press this button once to display the Aspect Ratio
select menu. Keep pressing will change aspect ratios.
See page 42.

9. POWER Button
Use this button to turn the power on and off when the
main power is supplied and the projector is in standby
mode.
To turn on the projector, press and hold this button for
a minimum of two seconds. To turn off the projector,
press this button once to display the confirmation
message and then press the POWER button or EN-
TER button.
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1. Introduction

CR2025

CR2025

30° 

30° 

30° 

30°

Remote Control Precautions
• Handle the remote control carefully.
• If the remote control gets wet, wipe it dry immediately.
• Avoid excessive heat and humidity.
• If you will not be using the remote control for a long time, remove the battery.
• Do not place the battery upside down.
• Keep the coin cell battery out of reach of children so as not to allow them to swallow the cell battery.

CAUTION
Danger of explosion if battery is incorrectly replaced.
Replace only with the same or equivalent type recommended by the manufacturer.
Dispose of used batteries according to your local regulations.

Operating Range for Wireless Remote Control

Battery Installation

1 Push the catch to the right
and remove the battery
holder.

2 Remove the old Lithium coin cell
and install new one (CR2032).
Ensure that the side with the
mark “+” is up.

3 Push the battery holder back into
the remote control until you feel a
click.

Remote sensor on projector cabinet Remote control

7m/22 feet

7m/22 feet

• The infrared signal operates by line-of-sight up to a distance of about 22 feet/7 m and within a 60-degree angle of
the remote sensor on the projector cabinet.

• The projector will not respond if there are objects between the remote control and the sensor, or if strong light falls
on the sensor.
Weak battery will also prevent the remote control from properly operating the projector.
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This section describes how to set up your projector and how to connect video and audio sources.

2. Installation and Connections

� Setting Up the Screen and the Projector
Selecting a Location 
The further your projector is from the screen or wall, the larger the image. The minimum size the image can be is
approximately 21" (0.53 m) measured diagonally when the projector is roughly 29 inches (0.73 m) from the wall or
screen. The largest the image can be is 300" (7.6 m) when the projector is about 393 inches (10 m) from the wall or
screen. Use the drawing below as a guide.

Your projector is simple to set up and use.
But before you get started, you must first:

z Set up a screen and the projector.

x Connect your computer or video equip-
ment to the projector. See pages 17 to
21.

c Connect the supplied power cable. See
page 22.

NOTE: Ensure that the power cable and any
other cables are disconnected before moving
the projector. When moving the projector or
when it is not in use, cover the lens with the
lens cap.

To the wall outlet.

300"

240"

200"
180"

150"
120"

100"

60"
40"30"21"

80"

Distance (U
nit: m

/inch)

Screen Size (Unit: cm/inch

Screen Size

Lens center

609.6(W)�457.2(H) / 240(W)�180(H)

487.7(W)�365.8(H) / 192(W)�144(H)

406.4(W)�304.8(H) / 160(W)�120(H)

365.8(W)�274.3(H) / 144(W)�108(H)

304.8(W)�228.6(H) / 120(W)�90(H)

243.8(W)�182.9(H) / 96(W)�72(H)

203.2(W)�152.4(H) / 80(W)�60(H)

162.6(W)�121.9(H) / 64(W)�48(H)

121.9(W)�91.4(H) / 48(W)�36(H)

81.3(W)�61.0(H) / 32(W)�24(H)

61.0(W)�45.7(H) / 24(W)�18(H)

42.7(W)�32(H) / 17(W)�13(H)

1.0/380.7/
29

2.0/78
2.6/104

3.3/130
4.0/157 5.0/196 6.0/236

6.6/262 8.0/314
10.0/393

AC IN

1.3/
51

32

1
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2. Installation and Connections
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2. Installation and Connections

Lens Center

Throw Angle (�)

Throw Distance (C)

Screen center

Screen Diagonal

Screen Width

Screen Height

Screen Bottom

(B)

(D)

AC IN

Throw Distance and Screen Size
The following shows the proper relative positions of the projector and screen. Refer to the table to determine the
position of installation.

Distance Chart

B = Vertical distance between lens center and
screen center

C = Throw distance
D = Vertical distance between lens center and

bottom of screen (top of screen for ceiling
application)

α = Throw angle

NOTE: Distances may vary +/-5%.

α
Wide – Tele

degree
–– – 9.9

12.0 – 9.8
11.9 – 9.8
11.7 – 9.7
11.6 – 9.6
11.6 – 9.6
11.6 – 9.6
11.6 – 9.6
11.5 – 9.6
11.5 – 9.6
11.5 – 9.5
11.5 – 9.5
11.5 – 9.5
11.5 – 9.5
11.5 – 9.5
11.5 – 9.5
11.4 – 9.5
11.4 – 9.5

inch
13
15
18
24
36
43
48
50
54
60
72
90

108
120
126
144
162
180

Screen Size B C
Wide – Tele

D
Diagonal Width Height

inch
–– – 29
28 – 34
34 – 42
46 – 56
70 – 85
84 – 102
93 – 113
98 – 119

105 – 128
117 – 142
141 – 171
176 – 214
212 – 257
236 – 285
247 – 300
283 – 343
319 – 386
354 – 429

inch
-1
-2
-2
-2
-4
-4
-5
-5
-6
-6
-7
-9

-11
-12
-13
-15
-17
-18

inch
5
6
7

10
14
17
19
20
22
24
29
36
43
48
50
57
65
72

inch
21
25
30
40
60
72
80
84
90

100
120
150
180
200
210
240
270
300

inch
17
20
24
32
48
58
64
67
72
80
96

120
144
160
168
192
216
240

α
Wide – Tele

degree
–– – 9.9

12.0 – 9.8
11.9 – 9.8
11.7 – 9.7
11.6 – 9.6
11.6 – 9.6
11.6 – 9.6
11.6 – 9.6
11.5 – 9.6
11.5 – 9.6
11.5 – 9.5
11.5 – 9.5
11.5 – 9.5
11.5 – 9.5
11.5 – 9.5
11.5 – 9.5
11.4 – 9.5
11.4 – 9.5

mm
320
381
457
610
914

1097
1219
1280
1372
1524
1829
2286
2743
3048
3200
3658
4115
4572

Screen Size B C
Wide – Tele

D
Diagonal Width Height

mm
––– – 730
720 – 870
870 – 1060

1170 – 1420
1770 – 2150
2130 – 2590
2370 – 2880
2490 – 3020
2670 – 3240
2970 – 3600
3580 – 4330
4480 – 5420
5380 – 6520
5980 – 7240
6280 – 7610
7190 – 8700
8090 – 9790
8990 – 10880

mm
-30
-40
-50
-60
-90

-110
-120
-130
-140
-160
-190
-230
-280
-310
-330
-370
-420
-470

mm
130
150
180
240
360
440
490
510
550
610
730
910

1090
1210
1270
1460
1640
1820

mm
533
635
762

1016
1524
1829
2032
2134
2286
2540
3048
3810
4572
5080
5334
6096
6858
7620

mm
427
508
610
813

1219
1463
1626
1707
1829
2032
2438
3048
3658
4064
4267
4877
5486
6096
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2. Installation and Connections

WARNING
* Installing your projector on the ceiling must be done

by a qualified technician. Contact your AV dealer for
more information.

* Do not attempt to install the projector yourself.
• Only use your projector on a solid, level surface. If the

projector falls to the ground, you can be injured and
the projector severely damaged.

• Do not use the projector where temperatures vary
greatly. The projector must be used at temperatures
between 41˚F (5˚C) and 95˚F (35˚C).

• Do not expose the projector to moisture, dust, or
smoke. This will harm the screen image.

• Ensure that you have adequate ventilation around your
projector so heat can dissipate. Do not cover the vents
on the side or the front of the projector.

Reflecting the Image
Using a mirror to reflect your projector's image enables
you to enjoy a much larger image. Contact your
dealer if you need a mirror system. If you're using a mir-
ror system and your image is inverted, use the MENU
and SELECT buttons on your projector cabinet or your
remote control to correct the orientation. See page 44.
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2. Installation and Connections

� Making Connections
NOTE: When using with a notebook PC, be sure to connect between the projector and the notebook PC before turning on the
power to the notebook PC. In most cases signal cannot be output from RGB output unless the notebook PC is turned on after
connecting with the projector.
* If the screen goes blank while using your remote control, it may be the result of the computer's screen-saver or power

management software.

AC IN

AUDIO OUT
MONITOR  OUT

PC CONTROL

AUDIO

S-VIDEO IN

COMPUTER 2 INVIDEO IN COMPUTER 1 INAUDIOL/MONO R

AUDIOL/MONO R

COMPUTER 1 IN

AUDIO

COMPUTER 2 IN

PHONE

PHONE

Connecting Your PC or Macintosh Computer

RGB signal cable (supplied)
To mini D-Sub 15-pin connector on the projector. It
is recommended that you use a commercially
available distribution amplifier if connecting a
signal cable longer than the supplied one.

Audio cable
(not supplied)

IBM PC or Compatibles (Desktop type)
or Macintosh (Desktop type)

NOTE: For older Macintosh, use a
commercially available pin adapter
(not supplied) to connect to your
Mac's video port.

IBM VGA or Compatibles (Notebook
type) or Macintosh (Notebook type)

Connecting your PC or Macintosh computer to your projector will enable you to project your computer's screen image
for an impressive presentation.

To connect to a PC or Macintosh, simply:
1. Turn off the power to your projector and computer.
2. Use the supplied signal cable to connect your PC or Macintosh to the projector.
3. Connect the supplied power cable. See page 22.
4. Turn on the projector and the computer.
5. If the projector goes blank after a period of inactivity, it may be caused by a screen saver installed on the computer

you've connected to the projector.

NOTE: The COMPUTER 1 connector supports Plug & Play (DDC2).

Enabling the computer’s external display
Displaying an image on the notebook PC’s screen does not necessarily mean it outputs a signal to the projector.
When using a PC compatible laptop, a combination of function keys will enable/disable the external display.
Usually, the combination of the ‘Fn” key along with one of the 12 function keys gets the external display to come on
or off. For example, NEC laptops use Fn + F3, while Dell laptops use Fn + F8 key combinations to toggle through
external display selections.
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NOTE: An image may not be displayed correctly when a Video or S-Video source is played back via a commercially available scan
converter.
This is because the projector will process a video signal as a computer signal at the default setting. In that case, do the following.
* When an image is displayed with the lower and upper black portion of the screen or a dark image is not displayed correctly:

Project an image to fill the screen and then press the AUTO ADJ button on the remote control or the AUTO ADJUST button on
the projector cabinet.

2. Installation and Connections

AC IN

AUDIO OUT
MONITOR  OUT

PC CONTROL

AUDIO

S-VIDEO IN

COMPUTER 2 INVIDEO IN COMPUTER 1 INAUDIOL/MONO R

AUDIOL/MONO R

COMPUTER 1 IN

Before connections: An exclusive SCART adapter (ADP-SC1) and a commercially available SCART cable are re-
quired for this connection.

NOTE: Audio signal is not available for this connection.

1. Turn off the power to the projector and your video equipment.

2. Use the ADP-SC1 SCART adapter and a commercially available SCART cable to connect the RGB input of
your projector and a SCART output (RGB) of your video equipment.

3. Connect the supplied power cable. See page 22.

4. Turn on the power to the projector and your video equipment.

5. Use the COMPUTER 1 button on the remote control to select the COMPUTER 1 input.
Use the COMPUTER button on the remote control to select the COMPUTER input on VT47.

6. Press the MENU button on the remote control to display the menu.

7. From the menu, select [Advanced] → [Signal Select] → [Computer 1 ([Computer] on VT47)] → [Scart].
SCART is a standard European audio-visual connector for TVs, VCRs and DVD players. It is also referred to as
Euro-connector.

NOTE: The ADP-SC1 SCART adapter is obtainable from your dealer in Europe. Contact your dealer in Europe for more
information.

To connect SCART output (RGB) (Europe Operation)

Video equipment such as DVD player

Commercially available SCART cable

Female

ADP-SC1

Projector

To COMPUTER 1 input
(COMPUTER input on VT47)
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2. Installation and Connections

Connecting an External Monitor

MONITOR OUT AUDIO

AC IN

AUDIO OUT
MONITOR  OUT

PC CONTROL

AUDIO

S-VIDEO IN

COMPUTER 2 INVIDEO IN COMPUTER 1 INAUDIOL/MONO R

AUDIOL/MONO R

MONITOR OUT 

You can connect a separate, external monitor to your projector to simultaneously view on a monitor the RGB analog
image you're projecting.

To do so:
1. Turn off the power to your projector, monitor and computer.

2. Use a 15-pin cable to connect your monitor to the MONITOR OUT (Mini D-Sub 15 pin) connector on your projector.

3. Connect the supplied power cable. See page 22.

4. Turn on the projector, monitor and the computer.

NOTE: Daisy chain connection is not possible.

RGB signal cable (supplied)

RGB signal cable (not supplied)
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AUDIO IN
L RAUDIO OUT

L R

Component

Y Cb Cr

AC IN

AUDIO OUT
MONITOR  OUT

PC CONTROL

AUDIO

S-VIDEO IN

COMPUTER 2 INVIDEO IN COMPUTER 1 INAUDIOL/MONO R

AUDIOL/MONO R

COMPUTER 1 IN AUDIO

2. Installation and Connections

NOTE: Refer to your DVD player's owner's manual for more information about your DVD player's video output requirements.

Connecting Your DVD Player with Component Output

DVD player

Audio Equipment

Audio cable (not supplied)

Optional 15p - to - RCA (female)�3
cable (ADP-CV1)

Component video RCA�3
cable (not supplied)

You can connect your projector to a DVD player with component output or Video output. To do so, simply:

1. Turn off the power to your projector and DVD player.

2. If your DVD player has the component video (Y,Cb,Cr) output, use a commercially available component video cable
(RCA�3) and the optional 15-pin-to-RCA (female)�3 cable to connect your DVD player to the COMPUTER IN
connector on the projector.

For a DVD player without component video (Y,Cb,Cr) output, use common RCA cables (not provided) to connect a
composite VIDEO output of the DVD player to the Video Input of the projector.

3. Connect the supplied power cable. See page 22.

4. Turn on the projector and DVD player.

A component signal will be automatically displayed. If not, from the menu, select [Advanced] → [Signal Select] →
[Computer], and then place a check mark in the Component radio button.
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2. Installation and Connections

AUDIO IN
L RAUDIO OUT

L R

VIDEO OUT
S-VIDEOVIDEO

AC IN

AUDIO OUT
MONITOR  OUT

PC CONTROL

AUDIO

S-VIDEO IN

COMPUTER 2 INVIDEO IN COMPUTER 1 INAUDIOL/MONO R

AUDIOL/MONO R

S-VIDEO IN

VIDEO IN AUDIO

AUDIO

Connecting Your VCR or Laser Disc Player

S-Video cable (not supplied)

Video cable (not supplied)

VCR/ Laser disc player

Audio equipment

Audio cable (not supplied)

Use an RCA or S-Video cable (not provided) to connect the video and use RCA cables (not provided) to connect
the audio from your VCR, laser disc player or document camera to your projector.

To make these connections, simply:
1. Turn off the power to the projector and VCR, laser disc player or document camera.

2. Connect one end of an RCA cable to the video output (or one end of an S-Video cable to the S-Video output
connector) on the back of your VCR or laser disc player, connect the other end to the appropriate video input
on your projector. Connect one end of a pair RCA cables (not supplied) to the audio output on the back of your
VCR or laser disc player, connect the other end to your audio equipment or to the appropriate audio input on
the projector.
Be careful to keep the right and left channel connections correct for stereo sound.

3. Connect the supplied power cable. See page 22.

4. Turn on the projector and the VCR or laser disc player.

NOTE: Refer to your VCR or laser disc player owner's manual for more information about your equipment's video output
requirements.

NOTE: An image may not be displayed correctly when a Video or S-Video source is played back in fast-forward or fast-rewind via
a scan converter.
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2. Installation and Connections

AC IN

ZOOM

FOCUS

SELECT LAMPSTATUSPOWER

VIDEO

S-VIDEO
COMPUTER-1 COMPUTER-2

ON/STAND BY

AUTOADJ.

AUDIO OUT

S-VIDEO IN

COMPUTER 1 IN

COMPUTER  OUT PC CONTROL

AUDIO

AUDIO

COMPUTER 2 IN

VIDEO IN

AUDIO

L/MONO

R

AUDIO

L/MONO

R

Connecting the Supplied Power Cable
Connect the supplied power cable to the projector.
First connect the supplied power cable's two-pin plug to the AC IN of the projector, and then connect the other plug of
the supplied power cable in the wall outlet.

Make sure that the prongs are fully inserted into
both the AC IN and the wall outlet.

To wall outlet ←

CAUTION:
Do not unplug the power cable from the wall outlet under any one of the following circumstances.
Doing so can cause damage to the projector:

• While the Hour Glass icon appears.

• While the cooling fans are running. The cooling fans continue to work for 30 seconds after the projector is
turned off.
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3. Projecting an Image (Basic Operation)
This section describes how to turn on the projector and to project a picture onto the screen.

� Turning on the Projector

NOTE:
• The projector has two power switches: a main power switch and a POWER (ON/STAND BY) button.

• When plugging in or unplugging the supplied power cable, make sure that the main power switch is pushed to the off (�)
position. Failure to do so may cause damage to the projector.

AC IN

ZOOM

FOCUS

STATUS

LAMP

POWER

1. To turn on the main power to the projector, press the
Main Power switch to the on position ( I ).

• The POWER indicator will light orange.
See the Power Indicator section on page 56 for more
details.

2. Press the POWER (ON/STAND BY) button on the
projector cabinet or the POWER button on the remote

control for a minimum of 2 seconds. The POWER

indicator will turn to green and the projector will

become ready to use.

After you turn on your projector, ensure that the
computer or video source is turned on and that your
lens cap is removed.

NOTE: When no signal is available, a blue, black or logo screen is
displayed.
When the projector displays a blue or a black screen (not logo),
the Eco mode will be automatically selected in "Lamp Mode."

NOTE: If you turn on the projector immediately after the lamp is
turned off or when the temperature is high, the fans runs without
displaying an image for some time and then the projector will
display the image.

LAMP

STATUS

POWER VIDEO S-VIDEO

ON/STAND BY

SELECT

POWER

SOURCE PIC-MUTE

ASPECTMENU

UP

MAGNIFY PAGE

OFF

POWER

ON

PIC-MUTE

DOWN

8767A8070 8771

POWER POWER POWER

STATUS

LAMP

STATUS

LAMP

STATUS

LAMP

Standby Blinking Power On

Steady orange light Blinking green
light

Steady green
light

See page 56 for more details.
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3. Projecting an Image (Basic Operation)

Note on Startup screen (Menu Language Select screen)
When you first turn on the projector, you will get the Startup menu. This menu gives you the opportunity to select one
of the 8 menu languages.

To select a menu language, follow these steps:

1. Use the SELECT � or � button to select one of the 8
languages for the menu. LAMP

STATUS

POWER VIDEO

AUTO
ADJ.

S-VIDEO COMPUTER-1 COMPUTER-2

ON/STAND BY

SELECT

ENTER EXIT

MENU

UP

MAGNIFY PAGE

OFF

POWER

ON

PIC-MUTE

DOWN

SOURCE PIC-MUTE

SELECT

2. Press the ENTER button to execute the selection.

After this has been done, you can proceed to the menu opera-
tion.
If you want, you can select the menu language later. See "Lan-
guage" on pages 38 and 44.

LAMP

STATUS

POWER VIDEO

AUTO
ADJ.

S-VIDEO COMPUTER-1 COMPUTER-2

ON/STAND BY

SELECT

ENTER EXIT

MENU

UP

MAGNIFY PAGE

OFF

POWER

ON

PIC-MUTE

DOWN

SOURCE PIC-MUTE

SELECT

NOTE: Immediately after turning on the projector, screen flicker may occur. This is not a fault. Wait 3 to 5 minutes until the lamp
lighting is stabilized.

When the Lamp mode is set to Eco, the LAMP indicator will light green.
If one of the following things happens, the projector will not turn on.

• If the internal temperature of the projector is too high, the projector detects abnormal high temperature. In this
condition the projector will not turn on to protect the internal system. If this happens, wait for the projector's internal
components to cool down.

• When the lamp reaches its end of usable life, the projector will not turn on. If this happens, replace the lamp.

• If the lamp fails to light, and if the STATUS indicator flashes on and off in a cycle of six times, wait a full minute and
then turn on the power.

8767A/8070 8771

8767A/8070 8771
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3. Projecting an Image (Basic Operation)

� Selecting a Source
Selecting the computer or video source

VIDEO S-VIDEO COMPUTER-1 COMPUTER-2

LAMP

STATUS

POWER

AUTO
ADJ.

ON/STAND BY

SELECT

VOLUME

L-CLICK

MOUSE

R-CLICK

AUTO ADJ.

ASPECT HELP

FREEZEPICTURE

S-VIDEO

VIDEO COMPUTER

1

2

NOTE: Turn on the computer or VCR connected to the projector.

Using the cabinet buttons
Press any one of the COMPUTER 1/2 
VIDEO and S-VIDEO buttons.
The corresponding indicator will light green.

Using the Remote Control (8767A/8070)
Press any one of the COMPUTER 1/2, COMPONENT, VIDEO or S-
VIDEO buttons.

Selecting from the Source List (8771)
1. Press and quickly release the SOURCE button on the remote

control.

The Source list will be displayed. SOURCE PIC-MUTE

POWERASPECT

2. Press and quickly release the SOURCE button to select the
source in the Source list.

Each time the SOURCE button is pressed, the selection in the
Source list will change as follows:

8771

Computer 1 → Computer 2 → Video → S-Video → Computer 1 → ...

3. Press the ENTER button to display the selected source.

 NOTE: Highlighting the source for 2 seconds without pressing the ENTER
button will also display the selected source. SOURCE PIC-MUTE

POWERASPECT

8767A/8070

8771

8771

8771
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3. Projecting an Image (Basic Operation)

Detecting the Signal Automatically
Press and hold the SOURCE button for a minimum of 1 second, the
projector will search for the next available input source. Each time you
press and hold the SOURCE button for a minimum of 1 second, the
source will change as follows:

8771

Computer 1 → Computer 2 → Video → S-Video → Computer 1 → ...

If no input signal is present, the input will be skipped.

SOURCE PIC-MUTE

POWERASPECT

8771
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3. Projecting an Image (Basic Operation)

Place your projector on a flat level surface and ensure that the projector is
square to the screen.

Lift the front edge of the projector to center the image vertically.
* If the projected image does not appear square to the screen then use the

Keystone feature for proper adjustment. See page 29.

� Adjusting the Picture Size and Position

AC IN

ZOOM

FOCUS

AC IN

ZOOM

FOCUS

Adjust the Tilt Foot
1. Lift the front edge of the projector.

2. Push up the Adjustable Tilt Foot Levers on the right and left sides
of the projector to extend the adjustable tilt feet (maximum height).

3. Push down the Adjustable Tilt Foot Levers.

4. Lower the front of the projector to the desired height and release
the Adjustable Tilt Foot Lever to lock the Adjustable tilt foot. There
is approximately 10 degrees of up and down adjustment for the
front of the projector.

CAUTION
Do not use the tilt-foot for purposes other than originally intended. Misuses
such as gripping the tilt-foot or hanging on the wall can cause damage to the
projector.

2

ZOOM

FOCUS

SELECT

LAMP STATUS POWER

VIDEO

S-VIDEO
COMPUTER-1

COMPUTER-2

ON/STANDBY

AUTO ADJ.1

2

ZOOM

FOCUS

SELECT

LAMP STATUS POWER

VIDEO

S-VIDEO
COMPUTER-1

COMPUTER-2

ON/STAND BY

AUTO ADJ.

3

4

4

Adjustable Tilt Foot

Move the projector left to center the image horizontally on the screen.

Adjustable Tilt
Foot Lever

Adjustable Tilt
Foot Lever
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3. Projecting an Image (Basic Operation)

AC IN

ZOOM

FOCUS

ZOOM

FOCUS

AC IN

ZOOM

FOCUS

FOCUS

Focus
Use the FOCUS ring to obtain the best focus.

Zoom

Use the ZOOM lever to finely adjust the image size on the
screen.

NOTE: Digital Zoom can cause result in a blurry image because
zooming is made electronically.

8767A/8070/8771
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� Correcting Keystone Distortion
Auto Keystone Correction
The Auto Keystone correction feature will correct the vertical distortion of a projected image on the screen. No special
operation required. Just put the projector on a flat surface.
Note that the vertical keystone angle can be corrected between 30 degrees upward and 30 degrees downward of
projector tilt from level.

3. Projecting an Image (Basic Operation)

NOTE: Auto and Manual Keystone correction angle could be less than 30 degrees depending on some kinds of signal and aspect
ratios.

NOTE: The Auto Keystone Correction feature can cause an image to be slightly blurred because the correction is made electroni-
cally.

Manual Keystone Correction
You can also correct the vertical keystone distor-
tion manually.
To do so:

1. Press the MENU button.

The menu will be displayed.

2. Turn off the Auto Keystone function.

Use the SELECT � button to select
“Image” and then press the SELECT �
button. The “Auto Keystone” will be
displayed.  Press the SELECT � to select
“Off”.

3. Select the Keystone function.

Use the SELECT � button to select
“Keystone”.

4. Correct the vertical distortion.

Use the SELECT � or � button to correct
the vertical keystone distortion.

NOTE: The Keystone Correction feature can cause
an image to be slightly blurred because the
correction is made electronically.
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3. Projecting an Image (Basic Operation)

5. Press the MENU button to close the menu.

NOTE: You can save the changes using the Keystone Save
feature when you turn off the projector. See page 42.
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3. Projecting an Image (Basic Operation)

� Optimizing RGB Picture Automatically
Adjusting the Image Using Auto Adjust
Optimizing an RGB image automatically.
Press the Auto Adjust button to optimize an RGB image automatically.

[Poor picture]

[Normal picture]

VIDEO

AUTO
ADJ.

S-VIDEO COMPUTER-1 COMPUTER-2

VOLUME

S-VIDEO

VIDEO

L-CLICK

MOUSE

R-CLICK

AUTO ADJ.COMPUTER

ASPECT HELP

FREEZEPICTURE

1

2

Press the Auto Adjust button to fine-tune the computer image or to remove any vertical banding that might appear and
to reduce video noise, dot interference or cross talk (this is evident when part of your image appears to be shimmer-
ing). This function adjusts the clock frequencies that eliminate the horizontal banding in the image. This function also
adjusts the clock phase to reduce video noise, dot interference or cross talk. (This is evident when part of your image
appears to be shimmering.)
This adjustment may be necessary when you connect your computer for the first time.

NOTE:
Some signals may not be displayed correctly or take time.
• The Auto Adjust function does not work for component and video signal.
• If the Auto Adjust operation cannot optimize the RGB signal, try to adjust Horizontal/Vertical Position Clock and Phase

manually. See page 48.

� Turning Up or Down Volume

Increase volume

Decrease volume

VOLUME

S-VIDEO

VIDEO

L-CLICK

MOUSE

R-CLICK

AUTO ADJ.COMPUTER

ASPECT HELP

FREEZEPICTURE

1

2

SELECT

Decrease volume Increase volume

8767A/8070

 8767A/8070

      8771

Sound level from the speaker and the AU-
DIO OUT jack (Stereo mini) on the projec-
tor can be adjusted.

SOURCE PIC-MUTE

SELECT

8771
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� Turning off the Projector
To turn off the projector:

3. Projecting an Image (Basic Operation)

LAMP

STATUS

POWER VIDEO

AUTO
ADJ.

S-VIDEO COMPUTER-1 COMPUTER-2

ON/STAND BY

SELECT

POWER

SOURCE PIC-MUTE

ASPECT

SELECT

L-CLICK

ENTER EXIT

MENU

UP

MAGNIFY PAGE

OFF

POWER

ON

PIC-MUTE

DOWN

R-CLICK

First, press the POWER (ON/STAND BY) button on the
projector cabinet or the POWER OFF button on the re-
mote control. The “Power Off / Are you sure?” message
will appear.

CAUTION
Do not unplug the power cable from the wall outlet or do not turn off
the main power under any one of the following circumstances. Doing
so can cause damage to the projector:
• While the Hour Glass icon appears.
• While the cooling fans are running. (The cooling fans continue to

work for 30 seconds after the projector is turned off).

AC IN

ZOOM

FOCUS

� After Use
Preparation: Make sure that the projector is turned off.

1. Unplug the power cable.

2. Disconnect any other cables.

3. Retract adjustable tilt feet if extended.

4. Cover the lens with the lens cap.

5. Put the projector and its accessories in the supplied soft carrying case.

Secondly, press the ENTER button or press the POWER
(ON/STAND BY), the POWER OFF or the POWER button
again.
The power indicator will glow orange. After the projector
turns off, the cooling fans keep operating for 30 seconds
(Cooling-off time).
Immediately after turning on the projector and displaying
an image, you cannot turn off the projector for 60 sec-
onds.
Finally, turn off the Main Power switch. The power indica-
tor will go out.

 8767A/8070       8771

POWER

STATUS

LAMP

POWERPOWER

STATUS

LAMP

STATUS

LAMP

Power On Fan running Standby

Steady green light Blinking
orange light

Steady orange
light
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4. Convenient Features

 Turning off the Image and Sound
Press the PIC-MUTE button to turn off the image and sound for a short
period of time. Press again to restore the image and sound.

ENTER EXIT

MENU

UP

MAGNIFY PAGE

OFF

POWER

ON

PIC-MUTE

DOWN

SOURCE PIC-MUTE

SELECT

� Freezing a Picture (8767A/8070 only)

Press the FREEZE button to freeze a picture. Press again to resume
motion.

NOTE: The optional remote control PR52 (RD-408E) allows you to use this
feature on 8771.

VOLUME

S-VIDEO

ASPECT HELP

FREEZEPICTURE

1

2

� Enlarging and Moving a Picture (8767A/8070 only)

ENTER EXIT

MENU

UP

MAGNIFY PAGE

OFF

POWER

ON

PIC-MUTE

DOWN

You can enlarge the picture up to 400 percent.

To do so:

1. Press the MAGNIFY (+) button to magnify the picture.

To move the magnified image, use the SELECT button.

LAMP

STATUS

POWER VIDEO

AUTO
ADJ.

S-VIDEO COMPUTER-1 COMPUTER-2

ON/STAND BY

SELECT

2. Return the image to the original size.

ENTER EXIT

MENU

UP

MAGNIFY PAGE

OFF

POWER

ON

PIC-MUTE

DOWN

 8767A/8070      8771

 8767A/8070

 8767A/8070

 8767A/8070

NOTE: The optional remote control PR52 (RD-408E) allows you to use this
feature on 8771.
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4. Convenient Features

� Using Remote Mouse Receiver (8767A/8070)

The remote mouse receiver enables you to operate your computer’s mouse functions from the remote control. It is a
great convenience for clicking through your computer-generated presentations.

Connecting the remote mouse receiver to your computer
If you wish to use the remote mouse function, connect the mouse receiver and computer.
The mouse receiver can be connected directly to the computer’s USB port (type A).

NOTE: Depending on the type of connection or OS installed on your computer, you may have to restart your computer or change
your computer settings.

30˚

30˚

Remote mouse receiver

Computer

To USB port of PC or Macintosh

When operating a computer via the remote mouse receiver

Remote sensor on the
remote mouse receiver

7m/22 feet

When connecting using the USB terminal
For PC, the mouse receiver can only be used with a Windows 98/Me/XP* or Windows 2000 operating system.

* NOTE: In Windows XP, if the mouse cursor will not move correctly, do the following:
Clear the Enhance pointer precision check box underneath the mouse speed slider in the Mouse Properties dialog box [Pointer
Options tab].

NOTE: Wait at least 5 seconds after disconnecting the mouse receiver before reconnecting it and vice versa. The computer may
not identify the mouse receiver if it is repeatedly connected and disconnected in rapid intervals.

Operating your computer’s mouse from the remote control
You can operate your computer's mouse from the remote control.

PAGE UP/DOWN Button: scrolls the viewing area of the window or to move to the previous or next slide in PowerPoint
on your computer.

���� / Mouse Buttons: moves the mouse cursor on your computer.

MOUSE L-CLICK Button: works as the mouse left button.

MOUSE R-CLICK Button: works as the mouse right button.
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� Using the Menus

NOTE: The on-screen menu may not be displayed correctly while interlaced motion video image is projected.

1. Press the MENU button on the remote control or projector cabinet to display the Menu.

5. Using On-Screen Menu

ENTER EXIT

UP

MAGNIFY PAGE

OFF

POWER

ON

PIC-MUTE

DOWN

MENU

SOURCE PIC-MUTE

SELECT

2. Press the SELECT �� buttons on the remote control or the projector cabinet to highlight the menu for
the item you want to adjust or set.

ENTER EXIT

MENU

UP

MAGNIFY PAGE

OFF

POWER

ON

PIC-MUTE

DOWN

SOURCE PIC-MUTE

SELECT

ENTER EXIT

MENU

UP

MAGNIFY PAGE

OFF

POWER

ON

PIC-MUTE

DOWN

SOURCE PIC-MUTE

SELECT

3. Press the SELECT � button or the ENTER button on the remote control or the projector cabinet to select
a submenu or item.

 8767A/8070       8771

 8767A/8070       8771

 8767A/8070       8771
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5. Using On-Screen Menu

4. Use the SELECT �� buttons on the remote control or the projector cabinet to select the item you want
to adjust or set.

ENTER EXIT

MENU

UP

MAGNIFY PAGE

OFF

POWER

ON

PIC-MUTE

DOWN

SOURCE PIC-MUTE

SELECT

5. Adjust the level or turn the selected item on or off by using
SELECT � or � buttons on the remote control or the projector
cabinet.

The on-screen slide bar will show you the amount of increase
or decrease.

Changes are stored until you adjust it again.

EXIT ...................... Return to the previous menu.

6. Repeat steps 2-5 to adjust an additional item, or press the
MENU button to close the menu.

ENTER EXIT

UP

MAGNIFY PAGE

OFF

POWER

ON

PIC-MUTE

DOWN

MENU

SOURCE PIC-MUTE

SELECT

ENTER EXIT

MENU

UP

MAGNIFY PAGE

OFF

POWER

ON

PIC-MUTE

DOWN

SOURCE PIC-MUTE

SELECT

 8767A/8070      8771

 8767A/8070      8771

 8767A/8070      8771
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5. Using On-Screen Menu

� Menu Elements

Highlight

Title Slide bar

Off Timer remaining
time

Source

Radio button

Solid triangle

Check mark

Tab

Thermometer symbol

Key symbol

Menu windows or dialog boxes typically have the following elements:

Title .......................................... Indicates the menu title.
Highlight ................................... Indicates the selected menu or item.
Source ...................................... Indicates the currently selected source.
Remaining countdown time ..... Indicates the remaining countdown time when the Off Timer is preset.
Solid triangle ............................ Indicates further choices are available. A highlighted triangle indicates the item is active.
Tab ........................................... Indicates a group of features in a dialog box. Selecting on any tab brings its page to the front.
Radio button ............................ Use this round button to select an option in a dialog box.
Check mark .............................. Indicates the item is selected.
Slide bar ................................... Indicates settings or the direction of adjustment.
Key symbol .............................. Indicates the Cabinet Button Lock is enabled.
Thermometer symbol ............... Indicates the lamp mode is forcibly set to Eco mode because the internal temperature is too

high.
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� List of Menu Items

5. Using On-Screen Menu

Picture
Wall Color Off, Blackboard, Light yellow, Light green, Light blue, Sky blue, Light rose, Pink
Picture Management Presentation, Video, Movie, Graphic, sRGB

User
Base Setting Presentation, Video, Movie, Graphic, sRGB
Gamma Correction Dynamic, Black Detail, Natural
Brightness R,G,B
Contrast R,G,B

Brightness
Contrast
Sharpness
Color
Hue

Image
Auto Keystone On, Off
Keystone
Keystone Save On, Off
Aspect Ratio Normal, Wide Zoom, Cinema, Native
Cinema Position

Setup
Off Timer Off, 0:30, 1:00, 2:00, 3:00, 4:00, 6:00, 8:00
Lamp Mode Normal, Eco
Language Language-1 English, Deutsch, Français, Italiano, Español, Português, Nederlands

Language-2 Svenska, Norsk, Suomi,  Cesky , Magyar, Polski, Türkçe
Language-3 , , , , , , Dansk

Menu Color Select Color, Monochrome
Menu Display Time Manual, Auto 5 sec, Auto 15sec, Auto 45 sec
Background Blue, Black, Logo
Orientation Desktop Front, Ceiling Rear, Desktop Rear, Ceiling Front
Beep On, Off

Advanced
Security On, Off
Cabinet Button Lock, Unlock
Fan Mode High, Auto
Signal Select COMPUTER1* RGB/Component, RGB, Component, Scart

COMPUTER2 RGB/Component, RGB, Component
Video Auto, NTSC3.58, NTSC4.43, PAL, PAL-M, PAL-N, PAL60, SECAM
S-Video Auto, NTSC3.58, NTSC4.43, PAL, PAL-M, PAL-N, PAL60, SECAM

Page2 Power Management On, Off
Noise Reduction On, Off
Flicker Reduction On, Off
Auto Adjust Off, Normal, Fine
Horizontal
Vertical
Clock
Phase
Communication Speed  4800, 9600, 19200
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5. Using On-Screen Menu

NOTE: Some menu items are not available depending on the input source.

Default
Factory Default Current Signal

All Data
Clear Filter Usage
Clear Lamp Hour Meter

Information
Page1 Remaining Lamp Time, Lamp Hour Meter, Filter Usage, Projector Usage,

BIOS Version, Firmware Version, Data Version
Page2 Source Index, Horizontal Frequency, Vertical Frequency, Sync Polarity

Signal Type, Video Type, Sync Type, Interlace
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5. Using On-Screen Menu


 Menu Descriptions & Functions [Picture]

Using the Wall Color Correction [Wall Color]

This function allows for quick adaptive color correction in applications where the screen material is not white.
The following eight options are available.

• OFF • Blackboard
• Light yellow • Light green
• Light blue • Sky blue
• Light rose • Pink

Using Picture Management [Picture Management]

This option allows you to adjust neutral tint for yellow, cyan or magenta.
There are 5 factory presets optimized for various types of images, or you can set user adjustable settings.

Presentation .......... Recommended for making a presentation using a PowerPoint file
Video ..................... Recommended for regular picture such as TV program
Movie .................... Recommended for movies
Graphic .................. Recommended for graphics
sRGB ..................... Standard color values
User ...................... User adjustable
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5. Using On-Screen Menu

NOTE: When “sRGB”, “Graphic”, “Video” or “Movie” is selected, the brightness decreases slightly when compared to “Presenta-
tion”. This is not a malfunction.

User Adjust (when using User)
When selecting user adjustable presetting (User), the submenu will be displayed.
You can customize each gamma or color. To do so, first select “User” and press the ENTER button, and then proceed
the following steps.

Selecting Base Setting [Base Setting]
This feature allows you to use white balance or gamma values as reference data to optimize for various types of
images. You can select one of the following five settings.

• Presentation • Video
• Movie • Graphic
• sRGB

Selecting Gamma Correction Mode [Gamma Correction]
Each mode is recommended for :

Dynamic ................ Creates a high-contrast picture
Black Detail ........... Emphasizes detail in dark areas of the picture
Natural .................. Natural reproduction of the picture

Adjusting White Balance [Brightness RGB/Contrast RGB]
This allows you to adjust the white balance. Brightness for each color (RGB) is used to adjust the black level of the
screen; Contrast for each color (RGB) to adjust the white level of the screen.

Adjusting Brightness, Contrast, Sharpness, Color and Hue

Brightness ............. Adjusts the brightness level or the back raster intensity.
Contrast ................ Adjusts the intensity of the image according to the incoming signal.
Sharpness ............. Controls the detail of the image for Video.
Color ..................... Increases or decreases the color saturation level (not valid for RGB).
Hue ........................ Varies the color level from +/– green to +/– blue. The red level is used as reference. This adjustment is only

valid for Video and Component inputs (not valid for RGB).
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5. Using On-Screen Menu

� Menu Descriptions & Functions [Image]

Enabling Auto Keystone [Auto Keystone]
This feature allows the projector to detect its tilt and correct vertical distortion automatically.
To turn on the Auto Keystone feature, select “On”.

Correcting Vertical Keystone Distortion Manually [Keystone]
You can correct vertical distortion manually from the menu when “Auto Keystone” is turned off.
You can save the changes using the Keystone Save feature when you turn off the projector.

Saving Vertical Keystone Correction [Keystone Save]
This option enables you to save your current keystone settings.
Saving your change once affects all sources. The changes are saved when the projector is off.

Selecting Aspect Ratio [ Aspect Ratio]
Aspect Ratio allows you to select the best Aspect mode to display your source image. You can also display the Aspect
Ratio menu by pressing the “ASPECT” button on the remote control.

Normal

Standard
4:3 Aspect

When 16:9 is selected from
the source (i.e. DVD player),
the following selections will
display:

Normal

16:9 image displayed
in 4:3 mode

Wide Zoom Cinema Native

Left and right
stretched

Left and right
stretched

Wide Zoom Cinema Native

Left and right
stretched

Left and right stretched to
display the true aspect

Native (RGB only): Turns off the Advanced AccuBlend feature. The projector displays the current image in its true
resolution.

NOTE:
• While you are displaying an image at the projector’s native resolution or higher, “Native” is not available.
• You can adjust the image position for Cinema aspect. See “Cinema Position” for setting the image position.
Copyright
Please note that using this projector for the purpose of commercial gain or the attraction of public attention in a venue such as a
coffee shop or hotel and employing compression or expansion of the screen image with a "Aspect Ratio" setting may raise
concern about the infringement of copyrights which are protected by copyright law.

When 4:3 is selected from
the source (i.e. DVD player),
the following selections will
display:
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5. Using On-Screen Menu

Adjusting the Vertical Position of Image [Cinema Position] (for Cinema only)
This feature adjusts the vertical position of the image when viewing video with Cinema aspect ratio selected.
When “Cinema” is selected in “Aspect Ratio”, the image is displayed with black borders on the top and bottom.
You can adjust the vertical position between top and bottom.

NOTE: This option is available only when “Cinema” is selected in Aspect Ratio.

� Menu Descriptions & Functions [Setup]

Using Off Timer [Off Timer]
You can set the timer so that the projector turns itself off at the preset time.

1. Use the SELECT �� to select your desired time between 30 minutes and 8 hours: Off, 0:30, 1:00, 2:00,
3:00, 4:00, 6:00 and 8:00.

2. Press the ENTER button.

3. The Off Timer starts counting down remaining time.

4. The projector turns off after the countdown is complete.

NOTE:
• To cancel the preset time, select “Off” for the preset time or turn off the power.
• When the remaining time reaches 3 minutes before the projector is turned off, the “Projector will turn off in 3 minutes”

message will be displayed on the bottom of the screen.

Selecting Lamp Mode [Lamp Mode]
This feature enables you to select two brightness modes of the lamp:
Normal and Eco modes. The lamp life can be extended by using the Eco mode.

Normal Mode ........ This is the default setting (100% Brightness).
Eco Mode .............. Select this mode to increase the lamp life (80% Brightness).

NOTE: If the projector is overheated in Normal mode, there may be a case where the Lamp mode automatically changes to Eco
mode to protect the projector. When the projector is in Eco mode, the picture brightness decreases. When the projector comes
back to normal temperature, the Lamp mode returns to Normal mode.

NOTE: Thermometer symbol  indicates the lamp mode is automatically set to Eco mode because the internal temperature is too
high.
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5. Using On-Screen Menu

Selecting Menu Language [Language]
You can choose one of 21 languages for on-screen instructions.

Selecting Menu Color [Menu Color Select]
You can choose between two color modes for menu color: color and monochrome.

Selecting Menu Display Time [Menu Display Time]
This option allows you to select how long the projector waits after the last touch of a button to turn off the menu.
The preset choices are “Manual”, “Auto 5 sec”, “Auto 15 sec”, and “Auto 45 sec”. The “Auto 45 sec” is the factory
preset.

Selecting a Color or Logo for Background [Background]
Use this feature to display a black/ blue screen or logo when no signal is available.

Selecting Projector Orientation [Orientation]
This sets your image for your type of projection. The options are:
desktop front projection, ceiling rear projection, desktop rear projection, and ceiling front projection.

Enabling Key Sound and Error Sound [Beep]
This feature turns on or off the keypad sound or alarm when a button on the cabinet and the remote control is pressed
or an error occurs.
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5. Using On-Screen Menu

� Menu Descriptions & Functions [Advanced]

Security
A keyword can be set for your projector to avoid operation by an unauthorized user using the Menu. When a keyword
is set, turning on the projector will display the Keyword input screen. Unless the correct keyword is entered, the
projector cannot project an image.

To enable the Security function:
1. Select [Advanced] → [Security] and press the � button to select “On”.

The [Keyword] screen will be displayed.

The [Confirm Keyword] screen will be displayed.

2. Type in a combination of the four SELECT buttons ���� and press the ENTER button.

NOTE: A keyword must be four to 10 digits in length.
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3. Type in the same combination of SELECT buttons ���� and press the ENTER button.
The confirmation screen will be displayed.

4. Select “Yes” and press the ENTER button.
The Security function has been enabled.

To disable the Security function:
1. Select [Advanced] → [Security] and press the � button to select “Off”.

2. Type in your keyword and press the ENTER button.
When the correct keyword is entered, the Security function will be disabled.

When the Security function is enabled and the projector is turned on, the projector will display a blue
background.

To display an image at this time, press the MENU button to display the Keyword input screen.

The Keyword confirmation screen will be displayed.

Type in the correct keyword and press the ENTER button. The projector will display an image.

NOTE:
• The security disable mode is maintained until the main power is turned off (by setting the main power switch to “O” or

unplugging the power cable).
• If you forget your keyword, contact your dealer. Your dealer will provide you with your keyword in exchange for your request

code. Your request code is displayed in the Keyword Confirmation screen. In this example “K992-45L8-JNGJ-4XU9-1YAT-
EEA2” is a request code.
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Disabling the Cabinet Buttons [Cabinet Button Lock]
This option turns on or off the Cabinet Button Lock function.

NOTE:
• This Cabinet Button Lock does not affect the remote control and the PC Control functions.
• When the cabinet buttons are unlocked, pressing and holding the EXIT button for about 10 seconds will change the setting to

enable.
• Key symbol  indicates the Cabinet Button Lock is enabled.

Enabling High Speed Fan Mode [Fan Mode]
This option allows you to select two modes for fan speed: High speed mode and Auto mode.

High ...................... The built-in fans run at a fixed high speed.
Auto ...................... The built-in fans automatically run at a variable speed according to the internal temperature.

When you wish to cool down the temperature inside the projector quickly, select “High”.

NOTE: Select “High” if you continue to use the projector for consecutive days.

Selecting Signal Format [Signal Select]
[Computer]

Allows you to choose “Computer” for an RGB source such as a computer, or “Component” for a component video
source such as a DVD player. Normally select “RGB/Component” and the projector automatically detects a compo-
nent signal. However there may be some component signals that the projector is unable to detect. If this is the
case, select “Component”. Select “Scart” in Computer 1 for the European Scart signal.

[Video & S-Video System Select]
This feature enables you to select composite video standards manually. Normally select “Auto”.
When you select the video standard for Video and S-Video, select the video standard from the pull-down menu.
This must be done for Video and S-Video respectively.
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(Advanced Page 2)

Enabling Power Management [Power Management]
When this option is on and there is no input for five minutes or more, the projector will automatically turn itself off.

Turning On Noise Reduction [Noise Reduction] (not available for Video and S-Video signals)

Reduces video noise. Select “On” to enable the Noise Reduction feature.

Turning On Flicker Reduction [Flicker Reduction]
Reduces flicker which can occur in an interlaced signal. This feature is not available for RGB and HDTV signals.

NOTE: When the Flicker Reduction is ON, jagged lines can be visible depending on the signal. In that case, select OFF.

NOTE: This feature may not be available depending on your video equipment connected to the projector.

Setting Auto Adjust [Auto Adjust]
This feature sets the Auto Adjust mode so that the RGB image can be automatically or manually adjusted for noise
and stability. You can automatically make adjustment in two ways: Normal and Fine

Off ......................... The RGB image will not be automatically adjusted.
You can manually optimize the RGB image.

Normal .................. Default setting. The RGB image will be automatically adjusted. Normally select this option.
Fine ....................... Select this option if fine adjustment is needed. It takes more time to switch to the source than when “Nor-

mal” is selected.

Adjusting Position/Clock (when Auto Adjust is off)
This allows you to manually adjust the image horizontally and vertically, and adjust Clock and Phase.

[Horizontal/Vertical]
Adjusts the image location horizontally and vertically.
This adjustment is made automatically when the Auto Adjust is turned on.

[Clock] (available for RGB and HDTV signals only)
Use this item with the “Auto Adjust off” to fine tune the computer image or to remove any vertical banding that
might appear. This function adjusts the clock frequencies that eliminate the horizontal banding in the image. This
adjustment may be necessary when you connect your computer for the first time. This adjustment is made auto-
matically when the Auto Adjust is turned on.
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[Phase] (available for RGB and HDTV signals only)
Use this item to adjust the clock phase or to reduce video noise, dot interference or cross talk. (This is evident
when part of your image appears to be shimmering.)
Use “Phase” only after the “Clock” is complete.
This adjustment is made automatically when the Auto Adjust is turned on.

Selecting Communication Speed [Communication Speed]
This feature sets the baud rate of the PC Control port (DIN 8 Pin). It supports data rates from 4800 to 19200 bps.
The default is 19200 bps.
Select the appropriate baud rate for your equipment to be connected (depending on the equipment, a lower baud rate
may be recommended for long cable runs).

� Menu Descriptions & Functions [Information]

Displays the status of the current signal, remaining lamp (%), lamp/filter/projector usage time (hours) and version
information. The Information has two pages. The Information included is as follows:

[Page 1]
Remaining Lamp Time (%)*
Lamp Hour Meter (H)
Filter Usage
Projector Usage
* The progress indicator shows the percentage of remaining bulb life. The value informs you of the amount of

lamp usage. When the remaining lamp time reaches 0, the Remaining Lamp Time bar indicator changes
from 0% to 100 Hours and starts counting down.

If the remaining lamp time reaches 0 hours, the projector will not turn on regardless of whether the lamp
mode is set to Normal or Eco.

BIOS Version
Firmware Version
Data Version

[Page 2]
Source Index
Horizontal Frequency
Vertical Frequency
Sync Polarity
Signal Type
Video Type
Sync Type
Interlace
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� Menu Descriptions & Functions [Default]

Returning to Factory Default [Factory Default]
The Factory Default feature allows you to change adjustments and setting to the factory preset.

[Current Signal]
Resets the adjustments for the current signal to the factory preset levels.
The items that can be reset are: Brightness, Contrast, Color, Hue, Sharpness, Noise Reduction, Aspect Ratio,
Horizontal Position, Vertical Position, Clock, Phase and Picture Management.

[All Data]
Reset all the adjustments and settings for all the signals to the factory preset for source except the following:
Language, Security, Communication Speed, Remaining Lamp Time, Lamp Hour Meter, Filter Usage and Projector
Usage. To reset the lamp usage time, see “Clear Lamp Hour Meter” and “Clear Filter Usage”.

Resetting the Filter Usage Hours [Clear Filter Usage]
Resets the filter usage back to zero. Selecting this option displays submenu for a confirmation. Select “Yes” and press
the ENTER button.

Clearing Lamp Hour Meter [Clear Lamp Hour Meter]
Resets the lamp clock back to zero. Selecting this option displays submenu for a confirmation. Select “Yes” and press
the ENTER button.

NOTE: The projector will turn off and go into standby mode after 2100 hours (up to 3100 hours in Eco mode) of service. If this
happens, do the following while in standby condition to clear values for the Lamp Hour Meter:
For 8767A/8070 press the HELP button on the remote control for a minimum of 10 seconds.
For 8771 press and hold the POWER and the EXIT buttons on the remote control simultaneously for a minimum of 10
seconds.
When the lamp time clock is reset to zero, the LAMP indicator goes out.
Do this only after replacing the lamp.
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ZOOM
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COMPUTER-2

ON/STANDBY

AUTO ADJ.

This section describes the simple maintenance procedures you should follow to clean the filter and replace the lamp.

� Cleaning or Replacing the Filter
The air-filter sponge keeps dust and dirt from getting inside the projector and should be cleaned after every 100 hours
of operation (more often in dusty conditions). If the filter is dirty or clogged, your projector may overheat.

CAUTION

• Turn off the projector, turn off the main power switch and unplug the projector before replacing the filter.

• Only clean the outside of the filter cover with a vacuum cleaner.

• Do not attempt to operate the projector without the filter cover.

To clean the air-filter:
Vacuum the filter-through the filter cover.

To reset the filter usage time, from the menu, select [Default] → [Clear Filter Usage].
See also page 50 for resetting the filter usage time.

To replace the filter (sponge):
1. Remove the filter cover by pushing down on the catch of the cover until you feel it detach.

Catch

2. Gently peel off the filter (sponge) and replace it with the new one.



52

6. Maintenance

3. Reinstall the new filter cover.

NOTE: Do not wash the filter with soap and water. Soap and water will damage the filter membrane. Before replacing the filter,
remove dust and dirt from the projector cabinet. Keep out dust and dirt during filter replacement.

NOTE: When you replace the lamp, it is also wise to replace the filter. The filter comes in the same package with your replacement
lamp.

� Cleaning the Cabinet and the Lens
1. Turn off the projector before cleaning.

2. Clean the cabinet periodically with a damp cloth. If heavily soiled, use a mild detergent. Never use strong
detergents or solvents such as alcohol or thinner.

3. Use a blower or lens paper to clean the lens, and be careful not to scratch or mar the lens.
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� Replacing the Lamp
After your lamp has been operating for 2000 hours (up to 3000 hours in Eco mode) or longer, the LAMP indicator in the
cabinet will blink red and the message will appear. Even though the lamp may still be working, replace it at 2000 (up to
3000 hours in Eco mode) hours to maintain optimal projector performance. After replacing the lamp, be sure to clear
the lamp hour meter. See page 50.

CAUTION

• DO NOT TOUCH THE LAMP immediately after it has been used. It will be extremely hot. Turn the projector off,
wait 30 seconds, turn off the main power switch and then disconnect the power cable. Allow at least one hour
for the lamp to cool before handling.

• DO NOT REMOVE ANY SCREWS except two lamp case screws. You could receive an electric shock.

• Do not break the glass on the lamp housing.

Keep finger prints off the glass surface on the lamp housing. Leaving finger prints in the glass surface might
cause an unwanted shadow and poor picture quality.

• The projector will turn off and go into stand by mode after 2100 (up to 3100 hours in Eco mode) hours of
service. If this happens, be sure to replace the lamp. If you continue to use the lamp after 2000 hours (up to
3000 hours in Eco mode) of use, the lamp bulb may shatter, and pieces of glass may be scattered in the lamp
case. Do not touch them as the pieces of glass may cause injury. If this happens, contact your NEC dealer for
lamp replacement.

To replace the lamp:
 Optional lamp and tools needed for replacement:

• Replacement lamp. 465-8767A (8767A/8070) or 465-8771 (8771).

• Phillips screwdriver or equivalent

NOTE: The two lamp houses are slightly different in appearance.
The following explanation uses drawings for the lamp 465-8767A.

1. Place the projector on a soft cloth and turn it over to access the lamp cover on the bottom.

6. Maintenance

2. Use a Philips screwdriver to push and release the tab.

Push up and remove the lamp cover.

Catch

Philips
screwdriver
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3. Loosen the two screws securing the lamp housing until the phillips screwdriver goes into a freewheeling
condition. The two screws are not removable.

Remove the lamp housing by holding it.

6. Maintenance

NOTE: There is an interlock on this case to prevent the risk of electrical shock. Do not attempt to circumvent this interlock.

4. Insert a new lamp housing until the lamp housing is plugged into the socket.

CAUTION
Do not use a lamp other than the Dukane replacement lamp 465-8767A (8767A/8070) or 465-8771 (8771).
Order this from your Dukane dealer.

Secure it in place with the two screws.

Be sure to tighten the screws.

5. Reattach the lamp cover.

Slip the lamp cover back until it snaps into place.

Interlock
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6. Finally, select the menu → [Default] → [Clear Lamp Hour Meter] to reset the lamp usage hours.

NOTE: When the lamp exceeds 2100 hours (up to 3100 hours in Eco mode) of service, the projector cannot turn on and the menu
is not displayed. If this happens, do the following while in standby condition to clear values for the Remaining Lamp Time and the
Lamp Hour Meter:
For 8767A/8070 press the HELP button on the remote control for a minimum of 10 seconds.
For 8771 press and hold the POWER and the EXIT buttons on the remote control simultaneously for a minimum of 10
seconds.
When the lamp time clock is reset to zero, the LAMP indicator goes out.
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� Troubleshooting
This section helps you resolve problems you may encounter while setting up or using the projector.

Indicator Messages

Power Indicator

Indicator Condition Projector Condition Note

Off
Blinking light

Steady light

Green

Orange

Green
Orange

0.5 sec On,
0.5 sec Off
2.5 sec On,
0.5 sec Off
0.5 sec On,
0.5 sec Off

The main power is off
The projector is getting ready to turn on.

Off Timer is enabled.

The projector is cooling down.

The projector is turned on.
The projector is in Standby.

–
Wait for a moment.

–

Wait for a moment.

–
–

Status Indicator

Indicator Condition Projector Condition Note

Off
Blinking light

Steady light

Red

Green

Orange

1 cycle (0.5 sec On,
2.5 sec Off)

2 cycle (0.5 sec On,
0.5 sec Of)

4 cycle (0.5 sec On,
0.5 sec Off)

6 cycle (0.5 sec On,
0.5 sec Off)

Normal
Lamp cover error or lamp housing error

Temperature error

Fan error

Lamp error

Re-firing the lamp (The projector is cool-
ing down.)
Cabinet button is locked

–
Replace the lamp cover or lamp
housing correctly.
The projector is overheated. Move
the projector to a cooler location.
Fans will not work correctly.

Lamp fails to light. Wait a full
minute and then turn on again.
The projector is re-firing.
Wait for a moment.
You have pressed cabinet button
when Cabinet Button is locked.

Lamp Indicator

Indicator Condition Projector Condition Note

Off
Blinking light

Steady light

Normal
Lamp has reached its end of life. Lamp
replacement message will be displayed.
Lamp has been used beyond its limit. The
projector will not turn on until the lamp is
replaced.
Lamp mode is set to Eco mode

Red

Red

Green

–
Replace the lamp.

Replace the lamp.

–



57

7. Appendix

Common Problems & Solutions (See also "Power/Status/Lamp Indicator" on page 56.)

Does not turn on

Will turn off

No picture

Picture suddenly
becomes dark

Color tone or hue is
unusual

Image isn’t square to
the screen

Picture is blurred

Image is scrolling
vertically, horizontally
or both

Remote control does
not work

Indicator is lit or
blinking

Cross color in RGB
mode

• Check that the power cable is plugged in and that the power button on the projector cabinet or the remote
control is on. See pages 22 and 23.

• Ensure that the lamp cover is installed correctly. See page 54.
• Check to see if the projector has overheated or the lamp usage exceeds 2100 hours (up to 3100 hours : Eco

mode). If there is insufficient ventilation around the projector or if the room where you’re presenting is par-
ticularly warm, move the projector to a cooler location.

• The lamp may fail to light. Wait a full minute and then turn on the power again.
• The lamp has reached the end of its usable life. Replace the lamp.

• Ensure that the Power Management is off. See page 48.

• Use the VIDEO, the S-VIDEO or the COMPUTER button (the SOURCE button on 8771) on the remote
control to select your source (Computer, Video or S-Video). See page 25. If there is still no picture, press the
button again.

• Ensure your cables are connected properly.
• Use menus to adjust the brightness and contrast. See page 41.
• Remove the lens cap.
• Reset the settings or adjustments to factory preset levels using the “Default” in the Menu. See page 50.
• Enter your registered keyword if the Security function is enabled. See page 45.
• When using with a notebook PC, be sure to connect between the projector and the notebook PC before turning

on the power to the notebook PC. In most cases signal cannot be output from RGB output unless the notebook
PC is turned on after connecting with the projector.
* If the screen goes blank while using your remote control, it may be the result of the computer's screen-

saver or power management software.
• See also the next page.

• When one of the following happens, the Lamp mode automatically changes from Normal to Eco.
* When there are no signals (blue or black screen) → To return to the Normal mode, select another available

source.
* When the image is muted using the PIC-MUTE button on the remote control → Press the PIC-MUTE button

again to return to the Normal mode.
* When the room where you' re presenting is particularly warm → Move the projector to a cooler location.

• Check if an appropriate color is selected in "Wall Color". If so, select an appropriate option. See page 40.
• Adjust "Hue" in "Picture". See page 41.

• Reposition the projector to improve its angle to the screen. See page 27.
• Use the Keystone correction function to correct the trapezoid distortion. See page 29.

• Adjust the focus. See page 28.
• Reposition the projector to improve its angle to the screen. See page 27.
• Ensure that the distance between the projector and screen is within the adjustment range of the lens. See

pages 13.
• Condensation may form on the lens if the projector is cold, brought into a warm place and is then turned on.

Should this happen, let the projector stand until there is no condensation on the lens.

• Use the SOURCE button on the projector cabinet or the VIDEO, the S-VIDEO or the COMPUTER button (the
SOURCE button on 8771) on the remote control to select your source (Video, S-Video or Computer).
See page 25.

• Adjust the computer image manually with the Horizontal/Vertical in the “Advanced → Page 2”. See page 48.

• Install new batteries.
8767A/8070: AAA�2. See page 10.
8771:       Lithium coin cell (CR2032). See page 12.

• Make sure there are no obstacles between you and the projector.
• Stand within 22 feet (7 m) of the projector. pages 10 for 8767A/8070 and 12 for 8771.

• See the POWER/STATUS/LAMP Indicator on page 56.

• Press the AUTO ADJUST button on the projector cabinet or the AUTO ADJ. button on the remote control. See
page 31.

• When “Off” is selected in Auto Adjust, adjust the computer image manually with Clock/Phase in “Advanced →
Page 2” in the menu. See page 48.

Problem Check These Items

For more information contact your dealer.
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If there is no picture, or the picture is not displayed correctly.

• Power on process for the projector and the PC.

Be sure to connect the RGB cable between the projector and the computer before turning on the computer.
There are some notebook PCs, which do not output signal unless there is a projector or monitor connected first.

NOTE: You can check the horizontal frequency of the current signal in the projector’s menu under Information.  If it reads
“0kHz”, this means there is no signal being output from the computer. See page 49 or go to next step.

• Enabling the computer’s external display.

Displaying an image on the notebook PC’s screen does not necessarily mean it outputs a signal to the projec-
tor.  When using a PC compatible laptop, a combination of function keys will enable/disable the external display.
Usually, the combination of the ‘Fn” key along with one of the 12 function keys gets the external display to come
on or off.  For example, NEC laptops use Fn + F3, while Dell laptops use Fn + F8 key combinations to toggle
through external display selections.

• Non-standard signal output from the computer

If the output signal from a notebook PC is not an industry standard, the projected image may not be displayed
correctly. Should this happen, deactivate the notebook PC’s LCD screen when the projector display is in use.
Each notebook PC has a different way of deactivate/reactivate the local LCD screens as described in the
previous step. Refer to your computer’s documentation for detailed information.

• Image displayed is incorrect when using a Macintosh

When using a Macintosh with the projector, set the DIPswitch of the Mac adapter (not supplied with the projec-
tor) according to your resolution. After setting, restart your Macintosh for the changes to take affect.

For setting display modes other than those supported by your Macintosh and the projector, changing the DIP
switch on a Mac adapter may bounce an image slightly or may display nothing. Should this happen, set the DIP
switch to the 13” fixed mode and then restart your Macintosh. After that, restore the DIP switches to a
displayable mode and then restart the Macintosh again.

NOTE: A Video Adapter cable manufactured by Apple Computer is needed for a PowerBook which does not have a mini D-Sub
15-pin connector.

• Mirroring on a PowerBook

* When using the projector with a Macintosh PowerBook, output may not be set to 1024 x 768 unless “mirror-
ing” is off on your PowerBook. Refer to owner’s manual supplied with your Macintosh computer for mirroring.

• Folders or icons are hidden on the Macintosh screen

Folders or icons may not be seen on the screen. Should this happen, select [View] → [Arrange] from the Apple
menu and arrange icons.
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� Specifications

This section provides technical information about the 8767A/8070/8771 Projector's performance.

Model Number 8767A/8070/8771

Optical
LCD Panel 0.7" p-Si TFT active-matrix (with Micro Lens Array on 8767A only)
Resolution 8767A/8771: 1024 � 768 pixels* native, up to UXGA.

8070: 800 � 600 pixels* native, up to UXGA with Advanced AccuBlend

Lens 8767A/8070/8771: Manual zoom and manual focus
F1.7 - 2.0   f=21.6 - 25.9 mm

Lamp 8767A/8070: 180W DC lamp (150W  Eco mode)
8771: 130W DC lamp (110W  Eco mode)

Image Size (Diagonal) 21 - 300 inches / 0.5 - 7.6 m

Projection Distance 2.4 - 35.89 ft / 0.73 - 10.9 m

Projection Angle Tele: 9.5° - 9.9°/ Wide: 11.5° - 12.0°

Keystone Correction +/- 30° Vertical (auto)

Electrical
Inputs 2 RGB/Component (D-Sub 15 Pin),

1 S-Video (DIN 4 Pin), 1 Video (RCA), 2 (L/R) RCA Audio,
1 Stereo Mini Audio, 1 PC Control (DIN 8 Pin)

Outputs 1 RGB (D-Sub 15 Pin), 1 Stereo Mini Audio (not available on VT47)
Video Compatibility NTSC, NTSC4.43, PAL, PAL-60, PAL-N, PAL-M, SECAM,

HDTV: 1080i, 1080i/50Hz, 720p, 576p, 480p, 480i/60Hz
Scan Rate Horizontal: 15 kHz to 100 kHz (RGB: 24 kHz or over)

Vertical: 50 Hz to 120 Hz
Video Bandwidth RGB: 80 MHz (-3dB)
Color Reproduction 16.7 million colors simultaneously, Full color
Horizontal Resolution NTSC / NTSC4.43/PAL/PAL-M/PAL-N/PAL60: 540 TV lines

SECAM: 300 TV lines
YCbCr: 800 TV lines
RGB: 8767A/8771: 1024 dots (H)�768 dots (V),
8070: 800 dots (H)�600 dots (V)

External Control RS232, IR
Sync Compatibility Separate Sync / Composite Sync / Sync on G
Built-in Speaker 1W (monaural)

* Effective pixels are more than 99.99%.
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Power Requirement 100 - 240V AC, 50 / 60 Hz
Input Current 8767A/8070: 2.7 - 1.4A (100 - 240V AC)

8771: 2.1 - 1.2A (100 - 240V AC)
Power Consumption 8767A/8070: 8W in Standby mode /

250W in Lamp Normal mode / 200W in Lamp Eco mode
8771: 8W in Standby mode /
190W in Lamp Normal mode / 155W in Lamp Eco mode

Mechanical
Installation Orientation Desktop/Front, Desktop/Rear, Ceiling/Front, Ceiling/Rear
Dimensions 11.6" (W)�3.7" (H)�10.2" (D)

294mm (W)�93mm (H)�260mm (D)
(not including protrusions)

Net Weight 6.5 lbs / 2.9 kg
Environmental Considerations Operational Temperatures : 41° to 95°F (5° to 35°C),

20% to 80% humidity (non-condensing)
Storage Temperatures : 14° to 122°F (-10° to 50°C),
20% to 80% humidity (non-condensing)

Regulations For United States:
UL Approved (UL 60950)
Meets FCC Class B requirements

For Canada:
UL Approved (CSA 60950)
Meets DOC Canada Class B requirements

For Australia/New Zealand:
Meets AS/NZS CISPR.22 Class B

For Europe:
Meets EMC Directive (EN55022, EN55024, EN61000-3-2, EN61000-3-3)
Meets Low Voltage Directive (EN60950, TUV GS Approved)

For additional information visit:
US : http://www.dukcorp.com/av

The specifications are subject to change without notice.
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� Cabinet Dimensions
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Mini D-Sub 15 Pin Connector
� Pin Assignments of D-Sub COMPUTER Input Connector

Signal Level
Video signal : 0.7Vp-p (Analog)
Sync signal : TTL level

5 14 23
10

1112131415
69 78

7. Appendix

* Only COMPUTER 1 input connector supported.

Pin No. RGB Signal (Analog) YCbCr Signal

1 Red Cr
2 Green or Sync on Green Y
3 Blue Cb
4 Ground
5 Ground
6 Red Ground Cr Ground
7 Green Ground Y Ground
8 Blue Ground Cb Ground
9 No Connection

10 Sync Signal Ground
11 SCART Sync
12 Bi-directional DATA (SDA)*
13 Horizontal Sync or Composite Sync
14 Vertical Sync
15 Data Clock*
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� Compatible Input Signal List
Signal Resolution Frequency H. Refresh Rate

( Dots ) ( kHz ) ( Hz )
NTSC – 15.734 60
PAL – 15.625 50
PAL60 – 15.734 60
SECAM – 15.625 50
VESA 640 � 480 31.47 59.94
IBM 640 � 480 31.47 60
MAC 640 � 480 31.47 60
MAC 640 � 480 34.97 66.67
MAC 640 � 480 35 66.67
VESA 640 � 480 37.86 72.81
VESA 640 � 480 37.5 75
IBM 640 � 480 39.375 75
VESA 640 � 480 43.269 85.01
IBM 720 � 350 31.469 70.09
VESA 720 � 400 37.927 85.04
IBM 720 � 350 39.44 87.85
IBM 720 � 400 39.44 87.85
VESA 800 � 600 35.16 56.25
VESA 800 � 600 37.879 60.32
VESA 800 � 600 48.077 72.19
VESA 800 � 600 46.88 75
VESA 800 � 600 53.674 85.06
MAC 832 � 624 49.725 74.55

@ VESA 1024 � 768 35.5 43 Interlaced
@ VESA 1024 � 768 48.363 60
@ VESA 1024 � 768 56.476 70.07
@ MAC 1024 � 768 60.241 74.93
@ VESA 1024 � 768 60.023 75.03
@ VESA 1024 � 768 68.677 85
@ # VESA 1152 � 864 67.5 75
@ # MAC 1152 � 870 68.681 75.06
@ # SUN 1152 � 900 61.796 65.95
@ # SGI 1152 � 900 71.736 76.05
@ # VESA 1280 � 960 60 60
@ # VESA 1280 � 1024 63.981 60.02
@ # MAC 1280 � 1024 69.89 65.18
@ # HP 1280 � 1024 78.125 72.01
@ # SUN 1280 � 1024 81.13 76.11
@ # VESA 1280 � 1024 79.976 75.03
@ # VESA 1280 � 1024 91.146 85.02
@ # SXGA+ 1400 � 1050 – –
@ # HDTV (1080p) 1920 � 1080 67.5 60 Progressive
@ # SDTV(576i)(625i) – 15.6 50
@ # SDTV(576p)(625p) – 31.5 50
@ # HDTV (1080i)(1125i) 1920 � 1080 33.75 60 Interlace
@ # HDTV (1080i)(1125i) 1920 � 1080 28.125 50 Interlace
@ # HDTV (720p)(750p) 1280 � 720 45 60 Progressive
@ # SDTV (480p)(525p) – 31.47 59.94 Progressive
@ # * VESA 1600 � 1200 75.0 60
@ # * VESA 1600 � 1200 81.25 65
@ # * VESA 1600 � 1200 87.5 70
@ # * VESA 1600 � 1200 93.75 75

DVD YCbCr – 15.734 59.94 Interlaced
DVD YCbCr – 15.625 50 Interlaced

# : Images in above flagged with # are compressed.
@ : Images in above flagged with @ are compressed.
* : Images in above flagged with * are not supported on other models.

NOTE: Some composite sync signals may not be displayed correctly.

Signals other than those specified in the table above may not be displayed correctly. If this should happen, change
the refresh rate or resolution on your PC. Refer to Display Properties help section of your PC for procedures.

UXGA (1600�1200) is supported for separate sync signal only.
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� PC Control Codes and Cable Connection
PC Control Codes 

Function Code Data
POWER ON 02H 00H 00H 00H 00H 02H
POWER OFF 02H 01H 00H 00H 00H 03H
INPUT SELECT COMPUTER 1 02H 03H 00H 00H 02H 01H 01H 09H
INPUT SELECT COMPUTER 2 02H 03H 00H 00H 02H 01H 02H 0AH
INPUT SELECT VIDEO 02H 03H 00H 00H 02H 01H 06H 0EH
INPUT SELECT S-VIDEO 02H 03H 00H 00H 02H 01H 0BH 13H
PICTURE MUTE ON 02H 10H 00H 00H 00H 12H
PICTURE MUTE OFF 02H 11H 00H 00H 00H 13H
SOUND MUTE ON 02H 12H 00H 00H 00H 14H
SOUND MUTE OFF 02H 13H 00H 00H 00H 15H

Cable Connection
Communication Protocol

Baud rate ........................................ 19200 bps
Data length ..................................... 8 bits
Parity .............................................. No parity
Stop bit .......................................... One bit
X on/off .......................................... None
Communications procedure ........... Full duplex

NOTE: Depending on the equipment, a lower baud rate may be recommended for long cable runs.

NOTE: Contact your local dealer for a full list of the PC Contorol Codes if needed.
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12

5 4 3

678

To RxD of PC

PC Control Connector (DIN-8P)

To TxD of PCTo GND of PC

NOTE: Pins 2, 3, 5, 6 and 8 are used inside the projector.
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� Optional Presentation Remote Control Kit (PR52KIT)

Part Names and Functions of the Remote Control

1. Infrared Transmitter/Laser Pointer
Transmits an infrared signal when any button other
than LASER is pressed.
Direct the remote control toward the remote sensor
on the projector cabinet.
Beams a laser light when the Laser button is pressed.
CAUTION:
* Do not look into the laser pointer while it is on.
* Do not point the laser beam at a person.

2. Remote Jack
Not available on this model.

3. LED
Flashes when any button is pressed.

4. POWER ON Button
When the main power is on, you can use this button
to turn your projector on.
NOTE: To turn on the projector, press and hold the
POWER ON button for a minimum of two seconds.

5. POWER OFF Button
You can use this button to turn your projector off.
NOTE: To turn off the projector, press the POWER OFF
button twice.

6. MAGNIFY (+)(–) Buttons
Use these buttons to adjust the image size.
The image can be magnified about the center of the
screen up to 400%.

7. LASER Button
Press and hold this button to activate the laser pointer.
When lit, you can use the laser to draw your audience's
attention to a red dot that you can place on any ob-
ject.

VOLUME

3D REFORM

PJ    OFF    MOUSE

FOCUS ZOOM

SLIDE

VIEWER

POINTER

LASER

UP

MAGNIFY PAGE

OFF
POWER

ON

PIC-MUTE

DOWN

AUTO ADJ.

SOURCE

ASPECT

HELP

FREEZE

PICTURE

EN
TE

R

MENU
EXIT

R-CLICK

2

5

6
8

10

12

9
7

15
16

4

1
3

20
17

13

11

18

22
19

25
27
29

28

23
26

21

24

14

The PR52KIT is an optional remote control kit for operating your projector and performing your computer mouse
operations.

Package List
• RD-408E remote control unit ....... 1 • AAA batteries ................... 2
• Mouse receiver ............................ 1 • User's manual .................. 1
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8. POINTER Button
Not available on this model.

9. PAGE UP/DOWN Buttons*
Use these buttons to operate your computer with the
supplied remote mouse receiver. You can use these
buttons to scroll the viewing area of the window or to
move to the previous or next slide in PowerPoint on
your computer.

10. MENU Button
Displays the menu for various settings and adjust-
ments.

11. Mouse Button
In Mouse mode*, this button works as your computer
mouse.
In Projector mode, this button is used for projector’s
menu operation and moving the magnified image.

12. ENTER Button
Executes your menu selection and activates items se-
lected from the menu.

13. EXIT Button
Returns to the previous menu.
While you are in the main menu, pressing this button
will close the menu.

14. L-CLICK Button*
Works as the mouse left button when the supplied
remote mouse receiver is connected with your com-
puter.

15. R-CLICK Button*
Works as the mouse right button when the supplied
remote mouse receiver is connected with your com-
puter.

16. PICTURE Button
Press this button to display the Picture window. Each
time this button is pressed, the option will be changed:
Wall Color → Picture Management → Brightness →
Contrast → Sharpness → Color → Hue

17. SOURCE Button
Use this button to select a video source such as a
PC, VCR or DVD player.
Press and release this button quickly to display the
Source List.
Each time this button is pressed for a minimum of
ONE second, the input source will change.
If no input signal is present, the input will be skipped.

18. ASPECT Button
Press this button to display the Aspect Ratio select
screen.

19. AUTO ADJ. Button
Use this button to adjust an RGB source for an opti-
mal picture.

20. VIEWER Button
Not available on this model.

21. SLIDE +/- Buttons
Not available on this model.

22. PIC-MUTE Button
This button turns off the image and sound for a short
period of time. Press again to restore the image and
sound.

23. HELP Button
Provides the Information screen.

24. VOLUME +/– Buttons
Press (+) to increase the volume and (–) to decrease
it.

25. FOCUS +/- Buttons
Not available on this model.

26. ZOOM +/- Buttons
Use to finely adjust the image on the screen.

27. FREEZE Button
This button will freeze a picture. Press again to re-
sume motion.

28. 3D REFORM Button
Not available on this model.

29. PJ � OFF � MOUSE Slide Switch
Use to switch mouse button operation modes between
Mouse and Projector. Setting to OFF will disable all
the buttons on the remote control.

*NOTE: The PAGE UP/DOWN, L-CLICK, R-CLICK and MOUSE
(as computer mouse) buttons are available only when the PJ
� OFF � MOUSE Slide Switch is set to MOUSE.
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30°

30°

30°

30°

Battery Installation

1 Remove the battery cover.
NOTE: Do not pull the battery
cover by force. Doing so can
result in it coming off.

2 Remove both old batteries and
install new ones (AAA). Ensure
that you have the batteries' po-
larity (+/ –) aligned correctly.

3 Slip the cover back over the bat-
teries until it snaps into place.
NOTE: Do not mix different types of
batteries or new and old batteries.

Remote sensor on projector cabinet Remote control

7m/22 feet

7m/22 feet

• The infrared signal operates by line-of-sight up to a distance of about 22 feet/7 m and within a 60-degree angle of
the remote sensor on the projector cabinet.

• The projector will not respond if there are objects between the remote control and the sensor, or if strong light falls
on the sensor.
Weak batteries will also prevent the remote control from properly operating the projector.

Remote Control Precautions
• Handle the remote control carefully.
• If the remote control gets wet, wipe it dry immediately.
• Avoid excessive heat and humidity.
• If you will not be using the remote control for a long time, remove the batteries.
• Do not place the batteries upside down.
• Do not use new and old batteries together, or use different types of batteries together.

Operating Range for Wireless Remote Control

1

2

1
2
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Using the Laser Pointer
You can use the laser to draw your audience's attention to a red dot that you can place on any object.

CAUTION:
• Do not look into the laser pointer while it is on.
• Do not point the laser beam at a person.
• Do not allow children to use the laser pointer.

Press and hold the LASER button to activate the laser pointer.

AC IN

ZOOM

FOCUS

LASER

To disable the laser pointer, set the function switch to “Off”.
Decide whether to enable or disable laser, then set the switch as necessary using the tip of a thin ball-point pen. On
this model, the other selector switch is not used.

ON

OFF

On: Enabled (the laser lights when the LASER button is pressed) [Factory default]
Off: Disabled (the laser does not light even when the LASER button is pressed)

Disable the laser when using in an environment in which the unit is accessible to children.

Using Remote Mouse Receiver (8767A/8070 only)
See page 34.

Not used

Laser enable/disable
switch
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No image is displayed from your PC or video equipment to the
projector.

Still no image even though you connect the projector to the PC
first, then start the PC.
Enabling your notebook PC’s signal output to the projector.
• A combination of function keys will enable/disable the ex-

ternal display. Usually, the combination of the “Fn” key along
with one of the 12 function keys turns the external display
on or off.

No image (blue background, logo, no display).
Still no image even though you press the AUTO ADJUST but-
ton.
Still no image even though you carry out “Reset” in the
projector’s menu.
Signal cable's plug is fully inserted into the input connector
A message appears on the screen.
( _____________________________________________ )
The source connected to the projector is active and available.
Still no image even though you adjust the brightness and/or
the contrast.
Input source's resolution and frequency are supported by the
projector.

7. Appendix

� Troubleshooting Check List
Before contacting your dealer or service personnel, check the following list to be sure repairs are needed also by
referring to the “Troubleshooting” section in your user’s manual. This checklist below will help us solve your problem
more efficiently.
* Print the following pages.

Frequency of occurrence � always � sometimes (How often?_____________________) � other (__________________)
Power

No power (POWER indicator does not light green)   See also “Sta-
tus Indicator (STATUS)”.

Power cable's plug is fully inserted into the wall outlet.
Main power switch is pressed to the ON position.
Lamp cover is installed correctly .
Lamp Hour Meter (lamp operation hours) was cleared after
lamp replacement.
No power even though you press and hold the POWER button
for a minimum of 2 seconds.

Shut down during operation.
Power cable's plug is fully inserted into the wall outlet.
Lamp cover is installed correctly .
Power Management is turned off (only models with the Power
Management function).
Sleep Timer is turned off (only models with the Sleep Timer
function ).

Video and Audio

Image is too dark.
Remains unchanged even though you adjust the brightness
and/or the contrast.

Image is distorted.
Image appears to be trapezoidal (unchanged even though you
carry out the “Keystone" or “3D Reform” adjustment).

Parts of the image are lost.
Still unchanged even though you press the AUTO ADJUST but-
ton.
Still unchanged even though you carry out “Reset” in the
projector’s menu.

Image is shifted in the vertical or horizontal direction.
Horizontal and vertical positions are correctly adjusted on a
computer signal.
Input source's resolution and frequency are supported by the
projector.
Some pixels are lost.

Image is flickering.
Still unchanged even though you press the AUTO ADJUST but-
ton.
Still unchanged even though you carry out “Reset” in the
projector’s menu.
Image shows flickering or color drift on a computer signal.

Image appears blurry or out of focus.
Still unchanged even though you checked the signal’s resolu-
tion on PC and changed it to projector’s native resolution.
Still unchanged even though you adjusted the focus.

No sound.
Audio cable is correctly connected to the audio input of the
projector.
Still unchanged even though you adjusted the volume level.
AUDIO OUT is connected to your audio equipment (only mod-
els with the AUDIO OUT connector).

Other
Remote control does not work.

No obstacles between the sensor of the projector and the re-
mote control.
Projector is placed near a fluorescent light that can disturb the
infrared remote controls.
One or more remote sensors are enabled (only models with
the Remote Sensor Selection function).
Batteries are new and are not reversed in installation.
If present on the remote control, projector selector switch is
not used.

Buttons on the projector cabinet do not work ( only models with
the Key Lock function).

Cabinet Button Lock is not turned on or is disabled in the menu.
Still unchanged even though you press and hold the EXIT but-
ton for a minimum of 10 seconds.
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In the space below please describe your problem in detail.

Information on application and environment where your projector is used

Projector

Model number:
Serial No.:
Date of purchase:
Lamp operating time (hours):
Lamp Mode: � Normal � Eco
Information on input signal:

Horizontal synch frequency [          ] kHz
Vertical synch frequency [          ] Hz
Synch polarity H � (+) � (–)

V � (+) � (–)
Synch type � Separate � Composite

� Sync on Green
STATUS Indicator:

Steady light � Orange � Green
Flashing light [          ] cycles

Remote control model number:

Signal cable

Standard or other manufacturer’s cable?
Model number:                        Length:              inch/m

Distribution amplifier
Model number:

Switcher
Model number:

Adapter
Model number:

Projector
PC

DVD player

Installation environment

Screen size: inch
Screen type: � White matte � Beads � Polarization

� Wide angle   � High contrast
 Throw distance: feet/inch/m
 Orientation: � Ceiling mount � Desktop
Power outlet connection:

� Connected directly to wall outlet
� Connected to power cord extender or other (the num-

ber of connected equipment______________)
� Connected to a power cord reel or other (the number

of connected equipment______________)

Computer

Manufacturer:

Model number:

Notebook PC � / Desktop �

Native resolution:

Refresh rate:

Video adapter:

Other:

Video equipment

VCR, DVD player, Video camera, Video game or other

Manufacturer:

Model number:





Dukane Corporation
Audio Visual Products Division
2900 Dukane Drive
St. Charles, IL 60174-3395
E-mail: avsales@dukcorp.com

Phone: (630) 762-4040
Orders: (800) 676-2485

Fax: (630) 584-5156
Parts & Service: (800) 676-2487

Fax: (630) 584-0984

Audio Visual Products

Part # 401-8767A_8771_8070-00


